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° Product comparison

° Product features

° Product walkaround

° Supported operating systems

e  Supported product software
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Product comparison

The product is available in the following configurations.

Base models Network models

e  Print letter-size pages at speeds up to 20 pages per Base model, plus:
minute (ppm) and A4-size pages at speeds up to 19 ppm.
e 10/100 Base-T Ethernet network port.

e  Priority input tray holds up to 10 sheets of print media.
e  |Pv4 network protocol.

e Tray 1 holds up to 250 sheets of print media or 10

envelopes. e  IPv6 network protocol.
e  Manual two-sided (duplex) printing and copying.
e Hi-Speed USB 2.0 port.

e  32-MB random-access memory (RAM).

e Flatbed scanner.

2 Chapter 1 Product basics ENWW



Product features

ENWW

Print

Prints letter-size pages at speeds up to 20 ppm and A4-size pages at speeds up to 19 ppm.

Prints at 600 dots per inch (dpi) and FastRes 1200 dpi.

Includes adjustable settings to optimize print quality.

Copy

Copies at 300 dots per inch (dpi).

Memory

Includes 32-megabyte (MB) random-access memory (RAM).

Paper handling

Priority input tray holds up to 10 pages.
Tray 1 holds up to 250 sheets of print media or 10 envelopes.

Output bin holds up to 100 sheets of print media.

Scan

Provides 1200 pixels per inch (ppi) full-color scanning.

Printer driver features

FastRes 1200 produces 1200-dots-per-inch (dpi) print quality for fast, high-quality printing

of business text and graphics.

Interface connections

All models include a Hi-Speed USB 2.0 port.

Network models include a 10/100 Base-T Ethernet network port.

Economical printing

Provides N-up printing (printing more than one page on a sheet).

Provides an EconoMode setting, which uses less toner.

Supplies The product ships with a 1,000-page (average yield) starter cartridge. The average yield
for replacement cartridges is 2,000 pages.
Accessibility Online user guide is compatible with text screen-readers.

Print cartridges can be installed and removed by using one hand.

All doors and covers can be opened by using one hand.

Product features
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Product walkaround

Front view

1 Scanner lid

2 Control panel

3 Print-cartridge door latch

4 Qutput bin

5 Priority input tray

6 Tray 1

Back view

7 Interface ports

8 Power switch

9 Power connector

4 Chapter 1 Product basics ENWW



Interface ports
All models have a Hi-Speed USB 2.0 port, and network models also have a 10/100 Base-T Ethernet

1 Hi-Speed USB 2.0 port

2 Ethernet port (network models only)

Serial number and model number location

The serial number and product model number label is on the rear of the product.

ENWW Product walkaround 5



Supported operating systems

The product supports the following operating systems:

Full software installation Print and scan drivers only
e  Windows XP (32-bit) e  Windows XP (64-bit)

e  Windows Vista (32-bit) e  Windows Vista (64-bit)

e  Windows 2000 e  Windows 2003 Server (64-bit)

e  Windows 2003 Server (32-bit)

° Mac OS X v10.3, v10.4, and later

Bf NOTE: ForMac OS X v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported product software

Software included with the product

There are several options for completing a recommended install. Easy installation will complete the
installation with default settings. Advanced installation allows you to review the license agreements and
the default settings.

Easy installation for Windows
e HP drivers
° Printer driver
o Scan driver
e HP MFP software
o HP LaserJet Scan program
° Uninstall program
e HP Update program
e  HP Customer Participation Program
e  Shop for HP Supplies program
e  Other programs

° Readiris OCR (not installed with other software; separate installation is required)

Advanced installation

Advanced installation includes all of the features that are available with the easy installation. The
HP Customer Participation program is optional.

6 Chapter 1 Product basics ENWW



Macintosh software
e HP Product Setup Assistant
e HP Uninstaller
e HP LaserJet software
o HP Scan
o HP Director
° Scan to e-mail program

° HP Photosmart

Supported printer drivers

The product comes with software for Windows and Macintosh that allows the computer to communicate
with the product. This software is called a printer driver. Printer drivers provide access to product
features, such as printing on custom-sized paper, resizing documents, and inserting watermarks.

Bf NOTE: The most recent drivers are available at www.hp.com/support/LJM1120. Depending on the
configuration of Windows-based computers, the installation program for the product software
automatically checks the computer for Internet access in order to obtain the latest drivers.

ENWW Supported product software 7
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2 Control panel

e Control-panel walkaround

e Control-panel menus
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Control-panel walkaround

1 Control-panel display

Shows status information, menus, and error messages

2 Left arrow button

Navigates to the previous item in the list, or decreases the value of numeric
items. With some numeric items, pressing the button once decreases the value
by 1, while pressing and holding the button decreases the value by 10.

3 Setup/OK button

Activates the control-panel menus
Clears an error condition when the condition is clearable
Saves the selected value for an item

Performs the action that is associated with the item that is highlighted on the
control-panel display

4 Right arrow button

Navigates to the next item in the list, or increases the value of numeric items.
With some numeric items, pressing the button once increases the value by 1,
while pressing and holding the button increases the value by 10.

5 Cancel button

Cancels the current print, copy, or scan job in process and expels all of the
active pages from the paper path. The time that it takes to cancel the job
depends on the size of the print job. (Press the button only once.) Also clears
continuable errors that are associated with the canceled job.

Exits the control-panel menus

6 More Copy Settings button

Provides access to copy settings for the current copy job

7 Lighter/Darker button

Provides access to copy contrast settings for the current copy job

8 # Copies button

Provides a way to change the number of copies printed for a the current copy
job

9 Start Copy button

Starts a copy job

10 Chapter 2 Control panel

ENWW



Control-panel menus

Use the control-panel menus

To gain access to the control-panel menus, use the following steps.

1.  Press Setup.
2. Use the arrow buttons to navigate the listings.

e Press OK to select the appropriate option.

e Press Cancel to cancel an action or return to the Ready state.

Control-panel main menus

These menus are available from the control-panel main menu:

e Use the Copy setup menu to configure basic copy default settings such as contrast, collation, or
the number of copies printed.

e Use the Reports menu to print reports that provide information about the product.

e Use the System setup menu to establish basic product settings such as language or print quality.

e Use the Service menu to restore default settings, clean the product, and activate special modes
that affect print output.

B NOTE: To print a detailed list of the entire control-panel menu and its structure, print a menu map.
See Information pages on page 70.

ENWW

Table 2-1 Copy setup menu

Menu item Sub-menu item Description
Default Quality Text Sets the default copy quality.
Draft
Mixed
Film photo
Picture
Def. light/dark Sets the default contrast option.
Def. # of copies (Range: 1-99) Sets the default number of copies.

Def. Reduce/Enlirg

Original=100%
Ad4—>Ltr=94%
Ltr->A4=97%
Full Page=91%
2 pages/sheet
4 pages/sheet

Custom:25-400%

Sets the default percentage to reduce or enlarge a copied
document.

Control-panel menus 11
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Table 2-2 Reports menu

Menu Item

Description

Demo page

Prints a page that demonstrates print quality.

Menu structure

Prints a control-panel menu layout map. The active settings for each menu are listed.

Config report

Prints a list of all the product settings. Includes network information when the product is
connected to the network.

Table 2-3 System setup menu

Menu Item Sub-menu item Sub-menu item Description

Language (List of available

Sets the language in which the control panel displays

control-panel messages and product reports.
display languages.)

Paper setup Def. paper size Letter Sets the size for printing internal reports or any print job that
does not specify a size.
A4
Legal
Def. paper type Lists available Sets the type for printing internal reports or any print job that
media types. does not specify a type.
Print Density (Range of 1-5) Sets how much toner the product should apply to thicken
lines and edges.
Table 2-4 Service menu
Menu item Sub-menu item Description

Restore defaults

Sets all customized settings to the factory default values.

Cleaning mode

Cleans the product when specks or other marks appear on printed
output. The cleaning process removes dust and excess toner from
the paper path.

When selected, the product prompts you to load plain Letter or A4
paper in tray 1. Press OK to begin the cleaning process. Wait until
the process completes. Discard the page that prints.

Less paper curl On When printed pages are consistently curled, this option sets the
product to a mode that reduces curl.
Off
The default setting is Off.
Archive print On When printing pages that will be stored for a long time, this option
sets the product to a mode that reduces toner smearing and
Off dusting.

The default setting is Off.

Chapter 2 Control panel
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Supported operating systems for Windows

The product supports the following Windows operating systems:

Full software installation Print and scan drivers only
e  Windows XP (32-bit) e  Windows XP (64-bit)

e  Windows Vista (32-bit) e  Windows Vista (64-bit)

e  Windows 2000 e  Windows 2003 Server (64-bit)

Windows 2003 Server (32-bit)

Printer driver

The product comes with software for Windows that allows the computer to communicate with the
product. This software is called a printer driver. Printer drivers provide access to product features, such
as printing on custom-sized paper, resizing documents, and inserting watermarks.

B NOTE: The most recent drivers are available at www.hp.com/support/LJM1120. Depending on the
configuration of Windows-based computers, the installation program for the product software
automatically checks the computer for Internet access in order to obtain the latest drivers.

Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

Bf NOTE: The names of commands and dialog boxes might vary depending on your software program.

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.
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Open the printer driver and change the print settings

ENWW

Operating System

To change the settings for all
print jobs until the software
program is closed

To change the default settings
for all print jobs

To change the device
configuration settings

Windows 2000, XP,
Server 2003, and
Vista

1.

On the File menu in the
software program, click
Print.

Select the driver, and then
click Properties or
Preferences.

The steps can vary; this
procedure is most common.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).

For Windows Vista, click
Start, click Control Panel,
and then click Printer.

Right-click the driver icon,
and then select Printing
Preferences.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).

For Windows Vista, click
Start, click Control Panel,
and then click Printer.

Right-click the driver icon,
and then select
Properties.

Click the Configure tab.

Open the printer driver and change the print settings 15



Software installation types for Windows
The following software installation types are available:
e Easy. Installs the full software solution.

e Advanced. Use this option to select which software and drivers to install.

Remove software for Windows
1. Click Start, and then click All Programs.
2. Click HP, and then click HP LaserJet M1120.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

16 Chapter 3 Software for Windows
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Supported utilities for Windows

Embedded Web server (network models only)

Network models are equipped with an embedded Web server, which provides access to information
about device and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page.)

Status Alerts software
The Status Alerts software provides information about the current status of the product.

The software also provides pop-up alerts when certain events occur, such as an empty tray or a problem
with the product. The alert includes information about solving the problem.

Other Windows components and utilities
e  Software installer — automates the printing system installation

e  Online Web registration

ENWW Supported utilities for Windows 17
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4 Use the product with Macintosh

e  Software for Macintosh

° Use features in the Macintosh printer driver

e Scan from the product and HP Director (Macintosh)

ENWW
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Software for Macintosh

Supported operating systems for Macintosh

The device supports the following Macintosh operating systems:

Mac OS X v10.3, v10.4 and later

B NOTE: For Mac OS v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh

The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.

The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Priority for print settings for Macintosh

Changes to print settings are prioritized depending on where the changes are made:

Bf NOTE: The names of commands and dialog boxes might vary depending on your software program.

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Macintosh

To change the settings for all print To change the default settings for all To change the device configuration

jobs until the software program is print jobs settings

closed

1. On the File menu, click Print. 1. On the File menu, click Print. 1. Inthe Finder, on the Go menu, click
Applications.

2. Change the settings that you want 2.  Change the settings that you want

on the various pop-up menus. on the various pop-up menus. 2. Open Utilities, and then open
Printer Setup Utility.
3. On the Presets pop-up menu, click
Save as and type a name for the 3.  Click on the print queue.
preset.
4. On the Printers menu, click Show
These settings are saved in the Info.
Presets menu. To use the new settings,
5.  Click the Installable Options
menu.
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To change the settings for all print To change the default settings for all To change the device configuration
jobs until the software program is print jobs settings
closed

you must select the saved preset option NOTE: Configuration settings might
every time you open a program and print. not be available in Classic mode.

Software installation types for Macintosh

Install Macintosh software for direct connections (USB)

1.

Insert the device CD into the CD-ROM drive and run the installer. If the CD menu does not run
automatically, double-click the CD icon on the desktop.

Double-click the Installer icon in the HP LaserJet Installer folder.
Follow the instructions on the computer screen.

USB printer queues are created automatically when the product is attached to the computer.
However, the queue will use a generic PPD if the installer has not been run before the USB cable
is connected. Complete the following steps to change the queue PPD.

On the computer hard drive, open Applications, open Utilities, and then open Printer Setup
Utility.

Select the correct printer queue, and then click Show Info to open the Printer Info dialog box.

In the pop-up menu, select Printer Model, and then, in the pop-up menu in which Generic is
selected, select the correct PPD for the device.

Print a test page from any software program to make sure that the software is correctly installed.

If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files on the device CD or the flyer that came in the box for help.

Install Macintosh software for networks (network models only)

ENWW

1.
2,

o

© ® N ©

Connect the network cable between the HP Jetdirect print server and a network port.

Insert the CD into the CD-ROM drive. If the CD does not run automatically, double-click the CD
icon on the desktop.

Double-click the Installer icon in the HP LaserJet Installer folder.
Follow the instructions on the computer screen.

On the computer hard drive, open Applications, open Utilities, and then open Printer Setup
Utility.

Click Add Printer.
Select the device from the list.
Click Add Printer.

Close the Print Center or the Printer Setup Utility.
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Supported utilities for Macintosh

Embedded Web server (network models only)

Network models are equipped with an embedded Web server, which provides access to information
about device and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page.)
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Use features in the Macintosh printer driver
Print

Create and use printing presets in Macintosh

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click Print.

2. Select the driver.

3. Select the print settings.
4. Inthe Presets box, click Save As..., and type a name for the preset.
5

Click OK.

Use printing presets
1.  On the File menu, click Print.
2. Select the driver.

3. Inthe Presets box, select the printing preset that you want to use.

B NOTE: To use printer-driver default settings, select Factory Default.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. Inthe area for Destination Paper Size, select Scale to fit paper size, and then select the size

from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page

You can print a separate cover page for your document that includes a message (such as “Confidential”).

1.  On the File menu, click Print.

2. Select the driver.

3. Open the Cover Page pop-up menu, and then select whether to print the cover page Before

Document or After Document.

4. Inthe Cover Page Type pop-up menu, select the message that you want to print on the cover

page.

Bf NOTE: To printa blank cover page, select Standard as the Cover Page Type.
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Print multiple pages on one sheet of paper in Macintosh

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

A w0 N

o

6.

AN

On the File menu, click Print.
Select the driver.
Open the Layout pop-up menu.

Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4,6, 9, or 16).

Next to Layout Direction, select the order and placement of the pages on the sheet.

Next to Borders, select the type of border to print around each page on the sheet.

Use the Services menu

If the device is connected to a network, use the Services menu to obtain device and supply-status
information.

1.
2,

On the File menu, click Print.
Open the Services menu.

Select a maintenance task from the drop-down list, and then click Launch. The embedded Web
server opens to the page that provides the information for the task that you selected.

To go to various support Web sites for this device, select an Internet Services option from the drop-
down list, and then click Go!.
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Scan from the product and HP Director (Macintosh)

For more information about tasks and settings described in this section, see the HP Director online Help.

Scanning tasks

To scan to a software program, scan an item using the program itself. Any TWAIN-compliant program
can scan an image. If the program is not TWAIN-compliant, save the scanned image to a file then place,
open, or import the file in the software program.

Use page-by-page scanning

1.

D @ Dd

o

Scan to file

1.
2.
3.

Scan to e-mail
1.
2,
3.

ENWW

Lift the flatbed scanner lid and load the original that is to be scanned face-down on the flatbed
scanner with the upper-left corner of the document at corner of the glass indicated by the icon on
the scanner. Gently close the lid.

Double-click the HP Director desktop alias.

Click the HP Director, and then click Scan to open the HP dialog box.

Click Scan.

To scan multiple pages, load the next page and click Scan. Repeat until all pages are scanned.

Click Finish, and then click Destinations.

In Destinations, choose Save To File(s).
Name the file and specify the destination location.

Click Save. The original is scanned and saved.

In Destinations, choose E-mail.
A blank e-mail opens with the scanned document as an attachment.

Enter an e-mail recipient, add text, or other attachments, then click Send.

Scan from the product and HP Director (Macintosh) 25
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Connectivity

e Connect the product directly to a computer with USB

° Printer sharing disclaimer

e Supported network operating systems

e  Supported network protocols

° Install the product on a network (network models only)
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Connect the product directly to a computer with USB

Bf NOTE: Do notconnectthe USB cable from the product to the computer until the installer prompts you
to do so.

1. Insert the product CD into your computer. If the software installer does not start, navigate to the
setup.exe file on the CD and double-click the file.

2. Follow the installer instructions.

3. Allow the installation process to complete, and then restart the computer.

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Supported network operating systems
The following operating systems support network printing:
e  Windows XP (32-bit and 64-bit)
e  Windows Vista (32-bit and 64-bit)
e  Windows 2000
e  Windows 2003 Server (32-bit and 64-bit)
e Mac OS X v10.3, v10.4, and later
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Supported network protocols
e TCP/IP

Install the product on a network (network models only)

Connect the product to the network
To connect a network model to a network, you need the following items:
e  Wired TCP/IP network
e  Ethernet cable (RJ-45)
1. Connect the Ethernet cable to an available port on the Ethernet hub or router.

2. Connect the Ethernet cable to the Ethernet port on the back of the product.

3. Verify that the green light is illuminated on the network port located on the back of the product.

4. Print a configuration page.

B NOTE: Do notconnect both a USB cable and an Ethernet cable to the product.

Install the software for the network product

To use the product on the network, install the software on a computer that is connected to the network.

ENWW Supported network protocols 29
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Paper and print media

° Understand paper and print media use

e Supported paper and print media sizes

e  Special paper or print media guidelines

° Load paper and print media

° Configure trays
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Understand paper and print media use

This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

e  Poor print quality
e Increased jams
e Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

/A CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes

This product supports a number of paper sizes, and it adapts to various media.

B NOTE: To obtain best print results, select the appropriate paper size and type in the print driver before

ENWW

printing.

Table 6-1 Supported paper and print media sizes

Size Dimensions Priority input tray Tray 1
Letter 216 x 279 mm (8.5 x 11 inches) ‘/ ‘/
Legal 216 x 356 mm (8.5 x 14 inches) \/ \/
A4 210 x 297 mm (8.27 x 11.69 inches) \/ \/
Executive 184 x 267 mm (7.24 x 10.51 inches) \/ \/
A3 297 x 420 mm (11.69 x 16.54 inches)

A5 148 x 210 mm (5.83 x 8.27 inches) \/ \/
A6 105 x 148 mm (4.13 x 5.83 inches) \/ \/
B5 (JIS) 182 x 257 mm (7.17 x 10.12 inches) \/ \/
16k 197 x 273 mm (7.75 x 10.75 inches) \/ \/
16k 195 x 270 mm (7.7 x 10.6 inches) \/ \/
16k 184 x 260 mm (7.25 x 10.25 inches) \/ \/
8.5x13 216 x 330 mm (8.5 x 13 inches) \/ \/
4x6' 107 x 152 mm (4 x 6 inches) \/ \/
5x8' 127 x 203 mm (5 x 8 inches) \/ \/
10 x 15 cm' 100 x 150 mm (3.9 x 5.9 inches) \/ \/
Custom Priority input tray: Minimum—76 x127 mm (3 x \/ \/

5 inches); Maximum—216 x 356 mm (8.5 x
14 inches)

1 These sizes are supported as custom sizes.

Table 6-2 Supported envelopes and postcards

Size Dimensions Priority input tray Tray 1
Envelope #10 105 x 241 mm (4.13 x 9.49 inches) \/ \/
Envelope DL 110 x 220 mm (4.33 x 8.66 inches) \/ \/

Supported paper and print media sizes
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Table 6-2 Supported envelopes and postcards (continued)

Size Dimensions Priority input tray Tray 1
Envelope C5 162 x 229 mm (6.93 x 9.84 inches)
Envelope B5 176 x 250 mm (6.7 x 9.8 inches)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 inches)

Postcard 100 x 148 mm (3.94 x 5.83 inches)

Double postcard 148 x 200 mm (5.83 x 7.87 inches)

ANANANANAN
ANANANENAN

Special paper or print media guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.

/A CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.

Media type Do Do not
Envelopes e  Store envelopes flat. e Do not use envelopes that are
wrinkled, nicked, stuck together, or
e Use envelopes where the seam otherwise damaged.
extends all the way to the corner of
the envelope. e Do not use envelopes that have
clasps, snaps, windows, or coated
e  Use peel-off adhesive strips that linings.
are approved for use in laser
printers. e Do not use self-stick adhesives or
other synthetic materials.
Labels e Use only labels that have no e Donotuse labels that have wrinkles
exposed backing between them. or bubbles, or are damaged.
e Use labels that lie flat. e Do not print partial sheets of labels.
e  Use only full sheets of labels.
Transparencies ° Use only transparencies that are o Do not use transparent print media

approved for use in laser printers.

Place transparencies on a flat
surface after removing them from
the product.

not approved for laser printers.

Letterhead or preprinted forms

Use only letterhead or forms
approved for use in laser printers.

e Do not use raised or metallic
letterhead.

Heavy paper

Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

e Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.
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Load paper and print media

Priority input tray

Tray 1

ENWW

The priority input tray is accessed from the front of the product. The product prints from the priority input
tray before attempting to print from tray 1.

The priority input tray holds up to 10 sheets of 75 g/m? (20 Ib) media or one envelope, one transparency,
orone card. You can use the priority input tray to print the first page on media different from the remainder
of the document.

Media guides ensure that the media is correctly fed into the product and that the print is not skewed

(crooked on the media). When loading media, adjust the media guides to match the width of the media
that you are using.

|

Tray 1 holds up to 250 pages of 75 g/m? (20 Ib) paper, or fewer pages of heavier media (25 mm (0.9 in)
or less stack height). Load media with the top forward and the side to be printed on facing down.

Media guides ensure that the media feeds correctly into the product and that the print is not skewed.
Tray 1 has side and rear media guides. When loading media, adjust the media guides to match the
length and width of the media that you are using.
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B NOTE: When you add new media, make sure that you remove all of the media from the input tray and
straighten the stack of new media. Do not fan the media. This reduces jams by preventing multiple
sheets of media from feeding through the product at one time.

Configure trays

To set the default paper size or type from the control panel, complete the following steps.
Configure trays for copy jobs

1. On the product control panel, press Setup.

2. Use the arrow buttons to select System setup, and then press OK.

3. Use the arrow keys to select Paper setup, and then press OK.

4. Use the arrow keys to select either Def. paper size or Def. paper type, and then press OK.

5. Use the arrow keys to select a default type or size for the tray, and then press OK.

Bf NOTE: To configure the product trays for print jobs, use the printer driver. See .Change the print driver
to match the media type and size on page 38.
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7 Print tasks

This section provides information about common printing tasks.

e Change the print driver to match the media type and size

e Get help for any print option

e Cancel a print job

e Create booklets

e Change print-quality settings

° Change print density

° Print on special media

° Use different paper and print covers

° Print a blank first page

° Resize documents

e Select a paper size

e  Select a paper source

e Select a paper type

° Set the print orientation

° Use watermarks

° Save toner

e Print on both sides of the paper (duplex printing)

° Print multiple pages on one sheet of paper in Windows

° Economy settings
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Change the print driver to match the media type and size

Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper,
and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always
print by Type for special print media, such as labels or transparencies. Always print by Size for
envelopes.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3.  Click the Paper/Quality tab.

4. Inthe Paper Type or Paper Size list box, select the correct media type or size.
5

Click OK.

Supported paper types and tray capacity
This product has the following tray priority for feeding print media:
1. Priority input tray
2. Tray1
Minimum media dimensions are 76 x 127 mm (3 x 5 in).
Maximum media dimensions are 216 x 356 mm (8.5 x 14 in).

To obtain the best print results, change the paper size and paper type settings in the printer driver before

printing.
Type is Media specifications Priority input tray Tray 1 capacity?
Plain 75g/m? (20 Ib)to 104 g/m? (27 Ib) Up to 10 sheets Up to 250 sheets
Color
Preprinted
Prepunched
Recycled
Light 60 g/m? (16 Ib) to 75 g/m? (20 Ib) Up to 10 sheets Up to 260 sheets
Envelopes Less than 90 g/m? (24 Ib) 1 envelope Up to 10 envelopes.
Labels Standard 1 sheet Not supported.
Bond 75g/m?(201b)to 104 g/m? (27 Ib) 1 sheet Up to 250 sheets
Rough 759/m?(20Ib)to 104 g/m? (27 Ib) 1 sheet Up to 200 sheets
Transparencies 4 mm (0.1 inches) Monochrome 1 sheet Up to 200 sheets.
Overhead
Heavy 110 g/m? (29 Ib) to 125 g/m? Up to 10 sheets Not supported.
(33 1b)
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Type is Media specifications Priority input tray Tray 1 capacity?

Letterhead 75 g/m? (20 Ib) to 104 g/m? (27 Up to 10 sheets Up to 250 sheets
Ib)

2 The maximum stack height for tray 1 is 25 mm (1 inch).

Get help for any print option

Printer-driver Help is separate from program Help. The printer-driver help provides explanations for the
buttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions for
performing common printing tasks, such as printing on both sides, printing multiple pages on one sheet,
and printing the first page or covers on different paper.

Activate the printer-driver Help screens in one of the following ways:

Windows Macintosh
e Inthe printer driver Properties dialog box, click the In the Print dialog box, click the ? button.
Help button.

e  Press the F1 key on the computer keyboard.

e  Click the question-mark symbol in the upper-right corner
of the printer driver.

e  Right-click on any itemin the driver, and then click What's
This?.
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Cancel a print job

If the print job is currently printing, cancel it by pressing Cancel on the product control panel.

Bf NOTE: Pressing Cancel clears the job that the product is currently processing. If more than one
process is running, pressing Cancel clears the process that currently appears on the product control
panel.

You can also cancel a print job from a software program or a print queue.

To stop the print job immediately, remove the remaining print media from the product. After printing
stops, use one of the following options:

e Device control panel: To cancel the print job, press and release Cancel on the product control
panel.

e Software program: Typically, a dialog box appears briefly on the computer screen, allowing you
to cancel the print job.

e Windows print queue: If a print job is waiting in a print queue (computer memory) or print spooler,
delete the job there.

° Windows 2000: Go to the Printer dialog box. Click Start, click Settings, and then click
Printers. Double-click the product icon to open the window, select the print job, and then click
Delete.

- Windows XP or Server 2003: Click Start, click Settings, and then click Printers and
Faxes. Double-click the product icon to open the window, right-click the print job that you want
to cancel, and then click Cancel.

° Windows Vista: Click Start, click Control Panel, and then, under Hardware and Sound,
click Printer. Double-click the product icon to open the window, right-click the print job that
you want to cancel, and then click Cancel.

e Macintosh print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.
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Create booklets

You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.

1.

2
3
4.
5

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
Click the Finishing tab.

Select Print On Both Sides.

In the drop-down box for Booklet Layout, select either Left Edge Binding or Right Edge
Binding. The Pages per Sheet setting automatically changes to 2 pages per sheet.

Click OK.

Change print-quality settings

1.
2,

On the File menu in the software program, click Print.

On the Paper/Quality tab, select the resolution or print-quality settings that you want from the Print
Quality drop-down menu.

Click OK.

Change print density

Increasing the print density darkens the print on the page.

ENWW

1.

2
3
4.
5

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
Click the Device Settings tab.

Use the Print Density slider to change the setting.

Click OK.
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Print on special media

Make sure that the paper or print media that you are using meets HP specifications. Generally, smoother
paper provides better results.

1. Open the media input tray and remove any media.

2. Load the media. Make sure that the top of the media is forward and the side to be printed on is
facing up.

3. Adjust the media guides to the length and width of the media.

4.  On the printer driver, on the Paper tab or the Paper/Quality tab, select the media type from the
Paper Type drop-down list.

/A CAUTION: Be sure to set the correct media type in the product settings. The product adjusts the
fuser temperature according to the media type setting. When printing on special media such as
transparencies or labels, this adjustment prevents the fuser from damaging the media as it passes
through the product.

5. Print the document.
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Use different paper and print covers

1.
2
3.
4
5.

6.
7.

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
On the Paper/Quality tab, select the appropriate paper.

Click Use different paper.

Select the pages that you want to use to print specific pages on different paper.

To print front or back covers, select Add Blank or Preprinted Cover.

Click OK.

Bf NOTE: The paper size must be the same for all pages of the print job.

Print a blank first page

ENWW

1.

2
3
4.
5
6

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
On the Paper/Quality tab, click Use different paper.

In the list box, click Front or Back Cover.

Click Add Blank or Preprinted Cover.

Click OK.

Use different paper and print covers
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Resize documents

Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.

Reduce or enlarge a document
1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, select % of normal size, and then type the percentage by which you want to
reduce or enlarge the document.

You can also use the scroll bar to adjust the percentage.

4. Click OK.

Print a document onto a different paper size
1. On the File menu in the software program, click Print.
2.  Select the driver, and then click Properties or Preferences.
3. On the Effects tab, click Print Document On.
4. Select the paper size to print on.
5. To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6. Click OK.

Select a paper size
1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. On the Paper/Quality tab, select the size from the Size is drop-down list.
4. Click OK.

Select a paper source
1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. On the Paper/Quality tab, select the source from the Source is drop-down list.
4

Click OK.

Select a paper type
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.
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On the Paper/Quality tab, select the type from the Type is drop-down list.
Click OK.

Set the print orientation

1.

2
3.
4

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
On the Finishing tab, select either Portrait or Landscape in the Orientation section.

Click OK.

Use watermarks

A watermark is a notice, such as "Confidential," that is printed in the background of each page of a

document.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. From the Effects tab, click the Watermarks drop-down list.

4. Click the watermark that you want to use.

5. If you want the watermark to appear only on the first page of the document, click First Page
Only.

6. Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.

Save toner

1.

2
3.
4

ENWW

On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.
On the Paper/Quality tab, click EconoMode.

Click OK.

Set the print orientation
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Print on both sides of the paper (duplex printing)

B NOTE: The printer driver also contains instructions and graphics for manually duplexing.

1. In the software program, open the properties (printer driver).

2. On the Finishing tab, select Print on Both Sides (Manually).

Bf NOTE: If the Print on Both Sides option is dimmed or unavailable, open the properties (printer
driver). On the Device Settings tab or the Configure tab, select Allow Manual Duplexing, and
then click OK. Repeat steps 1 and 2.

3. Print the document.

4. After one side has been printed, remove the remaining media from the input tray, and set it aside
until after you finish the duplexing job.

5. Without changing the orientation, remove the printed stack from the output bin, and then straighten
the stack.

i/
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6. Maintaining the same orientation, place the stack of media in the input tray again. The printed side
should be facing down with the top edge feeding into the product first.

7. On the product control panel, press OK and wait for the second side to print.
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Print multiple pages on one sheet of paper in Windows

You can print more than one page on a single sheet of paper.

AN

1. On the File menu in the software program, click Print.
Select the driver, and then click Properties or Preferences.

Click the Finishing tab.

A w0 N

In the Document Options drop-down list, select the number of pages that you want to print on
each sheet (1, 2, 4, 6, 9, or 16).

5. If the number of pages is greater than 1, select the correct options for Print page borders and
Page order.

e If you need to change the page orientation, click Portrait or Landscape.

6. Click OK. The product is now set to print the number of pages per sheet that you have selected.
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Economy settings

EconoMode

The EconoMode setting in the product printer driver conserves toner.

Archive print

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.

1. On the control panel, press Setup.
2. Use the arrow buttons to select Service, and then press OK.

3. Use the arrow buttons to select Archive print, select On or Off, and then press OK.
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Copy

e Load originals
e  Use copy

e  Copy settings
e Copy a book
e  Copy photos

e Duplex (two-sided) copy jobs
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Load originals

1. Lift the flatbed scanner cover.

2. Place the original document face-down on the flatbed scanner with the upper-left corner of the
document at the corner indicated by the icon on the scanner.

3.  Gently close the lid.

Use copy

One-touch copy

1. Load the document onto the flatbed scanner.
2. Press Start Copy on the product control panel to start copying.

3. Repeat the process for each copy.

Multiple copies

Change the number of copies for the current job
1. On the product control panel, press # of Copies.

2. Use the arrow buttons to set the number of copies (between 1 and 99) that you want to make for
your current job.

3. Press Start Copy to begin copying your job.

B NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Change the default number of copies
1. On the product control panel, press Setup.
2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. # of copies, and then press OK.

52 Chapter 8 Copy ENWW



4. Use the arrow buttons to set the number of copies (between 1 and 99) that you want as the default.

5. Press OK to save your selection.

Cancel a copy job

To cancel a copy job, press Cancel on the product control panel. If more than one process is running,
pressing Cancel clears the process that currently appears on the product control-panel display.

Bf NOTE: If you cancel a copy job, clear the document from the flatbed scanner.

Reduce or enlarge copies

Reduce or enlarge copies for the current job
1. On the product control panel, press More Copy Settings.
2. Use the arrow buttons to select Reduce/Enlarge, and then press OK.

3. Select the size to which you would like to reduce or enlarge the copies in this job.

Bf NOTE: If you select Custom: 25-400%, use the arrow keys to set a percentage.

If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

4. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

Bf NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

You must change the default media size in the media input tray to match the output size, or part of your
copy might be cut off.

Adjust the default copy size

B NOTE: The default copy size is the size to which copies are normally reduced or enlarged. If you keep
the factory default size setting of Original=100%, all copies will be the same size as the original
document.

1. Press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.

3. Use the arrow buttons to select Def. Redu/Enlrg, and then press OK.
4.

Use the arrow buttons to select the option for how you normally want to reduce or enlarge copies.

Bf NOTE: If you select Custom: 25-400%, use the arrow keys to set the percentage of the original
size that you normally want for copies.

If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

5. Press OK to save the selection.

The product can reduce copies to as little as 25% of the original size or enlarge copies to as much as
400% of the original size.
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Reduction/enlargement settings
e  Original=100%
o A4>Ltr=94%
o Ltr>A4=97%
e Full Page=91%
e 2 pages/sheet
e 4 pages/sheet
e  Custom: 25-400%

EE)

NOTE: When using the 2 pages/sheet or 4 pages/sheet setting, select the page orientation (portrait
or landscape).

Copy settings
Copy quality

Five copy-quality settings are available: Text, Draft, Mixed, Film photo, and Picture.
The factory-set default for copy quality is Text. This setting is the best for items that contain mostly text.

When making a copy of a photo or graphic, you can select the Film photo setting for photos or the
Picture setting for other graphics to increase the quality of your copy. Select the Mixed setting for
documents that include both text and graphics.

Adjust the copy quality for the current job

1. On the product control panel, press More Copy Settings twice to see the current quality setting for
the copy.

2. Use the arrow buttons to scroll through the quality setting options.

3. Select a setting, and then press Start Copy to save the selection and immediately start the copy
job, or press OK to save the selection without starting the job.

B NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default copy quality

1. On the product control panel, press Setup.

2. Use the arrow buttons to select Copy setup, and then press OK.
3. Use the arrow buttons to select Default quality, and then press OK.
4

Use the arrow buttons to select the copy quality, and then press OK to save the selection.
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Clean the scanner glass

Dirty glass, from fingerprints, smudges, hair, and so on, slows down performance and affects the
accuracy of special features such as fit-to-page and copy.

1. Turn off the product, unplug the power cord from the electrical socket, and raise the lid.

2. Clean the glass by using a soft, lint-free cloth or sponge that has been moistened with nonabrasive
glass cleaner.

/A CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids directly
on the glass. They might seep under it and damage the product.

3. To prevent spotting, dry the glass by using a chamois or cellulose sponge.

Adjust the lighter/darker (contrast) setting

The lighter/darker setting affects the lightness or darkness (contrast) of the copy. Use the following
procedure to change the contrast for the current copy job only.

Adjust the lighter/darker setting for the current job
1. On the product control panel, press Lighter/Darker to see the current contrast setting.

2. Use the arrow buttons to adjust the setting. Move the slider to the left to make the copy lighter than
the original, or move the slider to the right to make the copy darker than the original.

3. Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

B NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default lighter/darker setting

Bf NOTE: The default lighter/darker setting affects all copy jobs.

1. On the product control panel, press Setup.
2. Use the arrow buttons button to select Copy setup, and then press OK.

3. Use the arrow buttons button to select Def. Light/dark, and then press OK.
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4. Use the arrow buttons button to adjust the setting. Move the slider to the left to make all of the
copies lighter than the original, or move the slider to the right to make all of the copies darker than
the original.

5. Press OK to save the selection.

Change copy job print density
Increasing the print density at the product control panel darkens the print on the page.
1. On the control panel, press Setup.
2. Use the arrow buttons to select System setup, and then press OK.
3. Use the arrow buttons to select Paper setup, and then press OK.
4. Use the arrow buttons to select Print Density, and then press OK.

5. Use the arrow buttons to increase or decrease the density setting, and then press OK.

Define custom copy settings

When you change the copy settings at the control panel, Custom settings appears on the control-panel
display. The custom settings remain in effect for approximately 2 minutes, and then the product returns
to the default settings. To immediately return to the default settings, press Cancel.

Print or copy edge-to-edge

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x 13.7 in),
leaving a 4 mm unprintable border around the page.

Copy onto media of different types and sizes

The product is set to copy on either letter- or A4-size paper, depending on the country/region in which
it was purchased. You can change the size and type of media that you copy to for the current copy job
or for all copy jobs.

Media-size settings

° Letter
e Legal
° A4

Media-type settings
e Plain
e Preprinted
e Letterhead
e Transparency
e Prepunched

° Labels
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Bond
Recycled
Color

Light

Heavy
Cardstock
Envelope #10
Rough

Change the default media-size setting

1.

2
3
4.
5
6

On the product control panel, press Setup.

Use the arrow buttons to select System setup, and then press OK.
Use the arrow buttons to select Paper setup, and then press OK.
Use the arrow buttons to select Def. paper size, and then press OK.
Use the arrow buttons to select a media size, and then press OK.

Press OK to save the selection.

Change the default media-type setting

1.

2
3
4.
5
6

On the product control panel, press Setup.

Use the arrow buttons to select System setup, and then press OK.
Use the arrow buttons to select Paper setup, and then press OK.
Use the arrow buttons to select Def. paper type, and then press OK.
Use the arrow buttons to select a media type, and then press OK.

Press OK to save the selection.

Restore the copy-settings defaults

Use the control panel to restore the copy settings to the factory-set default values.

1.
2.
3.

ENWW

On the product control panel, press Setup.
Use the arrow buttons to select Copy setup, and then press OK.

Use the arrow buttons to select Restore defaults, and then press OK.

Copy settings
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Copy a book

1. Lift the lid and place the book on the flatbed scanner with the page that you want to copy at the
corner indicated by the icon on the scanner.

2.  Gently close the lid.

3.  Gently press down on the lid to press the book to the flatbed scanner surface.

/A CAUTION: Pressing on the flatbed cover with too much force can break the lid hinges.

4. Press Start Copy.
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Copy photos

1. Lift the lid and place the photo on the flatbed scanner with the picture-side down and the upper-
left corner of the photo at the corner indicated by the icon on the scanner.

2.  Gently close the lid.
3. Adjust the copy quality setting to Film photo.

4. Press Start Copy.

Duplex (two-sided) copy jobs

Copy a two-sided original to a one-sided document
Copies resulting from these procedures are printed on one side, and need to be hand-collated.

1. Load the first page of the document to be copied face-down onto the flatbed scanner, and then
close the scanner lid.

Press Start Copy.

Flip the page on the scanner to the second side, and then close the scanner lid.

> @ DN

Press Start Copy.

5. Repeat steps 1 through 4 for each page until all of the original document pages have been copied.
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Copying a two-sided original to a two-sided document

1. Load the first page of the document to be copied face-down onto the flatbed scanner, and then
close the scanner lid.

2. Press Start Copy.
3. Flip the page on the scanner to the second side, and then close the scanner lid.

4. Remove the copied page from the output bin and place it face down into the priority input tray with
the top edge feeding into the device first.

5. Press Start Copy.
6. Remove the copied page from the output bin, and then set it aside for manual collating.

7. Repeat steps 1 through 6, following the original document page order, until all pages of the original
are copied.

60 Chapter 8 Copy ENWW



ENWW

Scan

° Load originals for scanning

° Use scan

e  Scan settings

e Scan a book

e Scan aphoto
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Load originals for scanning

1. Lift the flatbed scanner cover.

2. Place the original document face-down on the flatbed scanner with the upper-left corner of the
document at the corner indicated by the icon on the scanner.

3.  Gently close the lid.

Use scan

Scan methods
Scan jobs can be performed in the following ways.
e Scan from the computer by using HP LaserJet Scan (Windows)

e Scanning by using HP Director (Macintosh). See Scan from the product and HP Director
(Macintosh) on page 25.

e  Scan from TWAIN-compliant or Windows Imaging Application (WIA)-compliant software

B NOTE: To learn about and use text-recognition software, install the Readiris program from the
software CD-ROM. Text-recognition software is also known as optical character recognition (OCR)
software.

Scan by using HP LaserJet Scan (Windows)
1. In the HP program group, select Scan to to start HP LaserJet Scan.
2. Select a scanning destination.

3. Click Scan.

Bf NOTE: OK should indicate the action that you want to accomplish.

Scan by using other software

The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product works
with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning devices and
with Macintosh-based programs that support TWAIN-compliant scanning devices.
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While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or the
documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the program
is compliant or you do not know what the command is called, see the software program Help or
documentation.

When scanning from a TWAIN-compliant program, the HP LaserJet Scan software program might start
automatically. If the HP LaserJet Scan program starts, you can make changes while previewing the
image. If the program does not start automatically, the image goes to the TWAIN-compliant program
immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program (Windows XP and Vista only)

WIA is another way to scan an image directly into a software program, such as Microsoft Word. WIA
uses Microsoft software to scan, instead of HP LaserJet Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner
or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see the
software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or documentation
for information about the commands and steps to use.

-Or-

In the Cameras and Scanner folder, double-click the product icon. This opens the standard Microsoft
WIA Wizard, which enables you to scan to a file.

Scanning by using optical character recognition (OCR) software

You can use third-party OCR software to import scanned text into your preferred word-processing
program for editing.

Readiris

The Readiris OCR program is included on a separate CD-ROM that shipped with the product. To use
the Readiris program, install it from the appropriate software CD-ROM, and then follow the instructions
in the online Help.

Canceling a scan job
To cancel a scan job, use one of the following procedures.
e  On the product control panel, press Cancel.
e Click the Cancel button in the onscreen dialog box.

If you cancel a scan job, remove the original from the flatbed scanner.
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Scan settings

Scan file format

The file format of a scanned document or photo depends on the scan type as well as the object being
scanned.

e Scanning a document or a photo to a computer results in the file being saved as a .TIF file.
e Scanning a document to email results in the file being saved as a .PDF file.

e Scanning a photo to e-mail results in the file being saved as a .JPEG file.

Bf NOTE: Different file types can be selected when using the scan software program.

Scanner resolution and color

1

1

If you are printing a scanned image, and the quality is not what you expected, you might have selected
a resolution or color setting in the scanner software that does not match your needs. Resolution and
color affect the following features of scanned images:

e Image clarity

e  Texture of gradations (smooth or rough)
e Scantime

e File size

Scanning resolution is measured in pixels per inch (ppi).

NOTE: Scanning ppi levels are not interchangeable with printing dpi (dots per inch) levels.

Color, grayscale, and black and white define the number of colors possible. You can adjust the scanner
hardware resolution to up to 1200 ppi. The software can perform an enhanced resolution up to

19,200 ppi. You can set color and grayscale at 1 bit (black and white), or at 8 bit (256 levels of gray or
color) to 24 bit (true color).

The resolution and color guidelines table lists simple tips that you can follow to meet your scanning
needs.

NOTE: Setting the resolution and color to a high value can create large files that take up disk space
and slow the scanning process. Before setting the resolution and color, determine how you are going
to use the scanned image.
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Resolution and color guidelines

The following table describes the recommended resolution and color settings for different types of scan

jobs.
Intended use Recommended resolution Recommended color settings
E-mail 150 ppi e  Black and White, if the image does not require
smooth gradation
e  Grayscale, if the image requires smooth gradation
e  Color, if the image is in color
Edit text 300 ppi e Black and White
Print (graphics or text) 600 ppi for complex graphics, orif you e  Black and White for text and line art
want to significantly enlarge the
document e  Grayscale for shaded or colored graphics and
photos
300 ppi for normal graphics and text
e  Color, if the image is in color
150 ppi for photos
Display on screen 75 ppi e Black and White for text

e  Grayscale for graphics and photos

e  Color, if the image is in color

Color

You can set the color values to the following settings when scanning.

Setting Recommended use

Color Use this setting for high-quality color photos or documents in which the color is important.
Black and White Use this setting for text documents.

Grayscale Use this setting when file size is an issue or when you want a document or photograph to

be scanned quickly.

Scan quality

Clean the scanner glass

Dirty glass, from fingerprints, smudges, hair, and so on, slows down performance and affects the
accuracy of special features such as fit-to-page and copy.

1. Turn off the product, unplug the power cord from the electrical socket, and raise the lid.
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2. Clean the glass by using a soft cloth or sponge that has been moistened with nonabrasive glass
cleaner.

/A CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids directly
on the glass. They might seep under it and damage the product.

3. To prevent spotting, dry the glass by using a chamois or cellulose sponge.
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Scan a book

1. Lift the lid and place the book on the flatbed scanner with the page that you want to copy at the
corner indicated by the icon on the scanner.

N
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2.  Gently close the lid.

3. Gently press down on the lid to press the book to the flatbed scanner surface.

/A CAUTION: Pressing on the flatbed cover with too much force can break the lid hinges.

4. Scan the book by using one of the scanning methods.
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Scan a photo

1. Place the photo on the flatbed scanner with the picture-side down and the upper-left corner of the
photo at the corner indicated by the icon on the scanner.

2.  Gently close the lid.

3. Scan the photo by using one of the scanning methods.
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Manage and maintain the product

° Information pages

° Embedded Web server (network models only)

e  Security features

° Manage supplies
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Information pages

Information pages reside within the product memory. These pages help diagnose and solve problems

with the product.

Bf NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System setup menu on the control panel or the embedded Web server (network models only).

See Control panel on page 9.

Page description

How to print the page

Demo page

Contains examples of text and graphics.

1.

2.

On the product control panel, press Setup.

Use the arrow buttons to select Reports, and then press
OK.

Use the arrow buttons to select Demo page, and then
press OK.

Menu map

Shows the control-panel menus and available settings.

On the product control panel, press Setup.

Use the arrow buttons to select Reports, and then press
OK.

Use the arrow buttons to select Menu structure, and then
press OK.

Configuration page

Shows the current settings and product properties.

On the product control panel, press Setup.

Use the arrow buttons to select Reports, and then press
OK.

Use the arrow buttons to select Config report, and then
press OK.
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Embedded Web server (network models only)

Network models are equipped with an embedded Web server (EWS), which provides access to
information about product and network activities. A Web server provides an environment in which web
programs may run, much in the same way that an operating system, such as Windows, provides an
environment for programs to run on a computer. The output from these programs can then be displayed
by a Web browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in
firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-

connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP address
for the product in the address line of the browser. (To find the IP address, print a configuration page.)

Features

The EWS allows you to view product and network status and manage printing functions from a computer.
With the EWS, you can complete the following tasks:

e View product status information

e Determine the remaining life on all supplies and order new ones
e View and change part of the product configuration

e View and print some internal pages

e Select the language in which to display the EWS pages

e View and change network configuration

Bf NOTE: Changing network settings in the EWS might disable some of product software or features.

Security features

Secure the embedded Web server
On network models, use the EWS to set a password.
1. Open the EWS, and then click the System tab.
2. Click Password.

3. Inthe Password box, type the password you want to set, and then in the Confirm password box,
type the same password again to confirm your choice.

4. Click Apply to save the password.
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Manage supplies

Check and order supplies

You can check the supplies status by using the product control panel. Hewlett-Packard recommends
that you place an order for a replacement print cartridge when Low message for a print cartridge first
appears. Use a new, authentic HP print cartridge to obtain the following types of supplies information:

e  Amount of cartridge life remaining
e  Estimated number of pages remaining
e Number of pages printed

e  Other supplies information

If the supplies levels are low, you can order supplies through a local HP dealer, by telephone, or online.
Go to www.hp.com/go/ljsupplies to order online.

Store supplies
Follow these guidelines for storing print cartridges:

e Do not remove the print cartridge from its package until you are ready to use it.

/A CAUTION: To prevent damage, do not expose the print cartridge to light for more than a few
minutes.

e  Store print cartridges within storage temperature ranges of -20° to 40° C (-4 to 104° F).

e  Store the supply in a horizontal position.

e  Store the supply in a dark, dry location away from heat and magnetic sources.

HP policy on non-HP supplies

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or
remanufactured. Because they are not HP products, HP cannot influence their design or control their

quality. Service or repairs required as a result of using a non-HP supply will not be covered under the
warranty.

HP fraud hotline
Call the HP fraud hotline if the product indicates that the print cartridge is not an HP print cartridge and
you think that it is genuine. HP will help determine if the product is genuine and take steps to resolve
the problem.
The print cartridge might not be a genuine HP one if you notice the following issues:
e You are experiencing a large number of problems with the print cartridge.
e The print cartridge does not look like it usually does (for example, the pull tab or the box is different).

In the United States, call toll-free: 1-877-219-3183.

Outside the United States, you can call collect. Dial the operator and ask to place a collect call to this
telephone number: 1-770-263-4745. If you do not speak English, a representative at the HP fraud hotline
who speaks your language will assist you. Or, if someone who speaks your language is not available,

72 Chapter 10 Manage and maintain the product ENWW


http://www.hp.com/go/ljsupplies

a language line interpreter will connect approximately one minute after the beginning of the call. The
language line interpreter is a service that will translate between you and the representative for the HP
fraud hotline.

Recycle supplies

To install a new HP print cartridge, follow the instructions that are included in the box that contains the
new supply, or see the getting started guide.

To recycle supplies, place the used supply in the box in which the new supply arrived. Use the enclosed
return label to send the used supply to HP for recycling. For complete information, see the recycling
guide that is included with each new HP supply item.

Redistribute toner

If faded or light areas appear on the printed page, you might be able to temporarily improve print quality
by redistributing the toner.

1. Remove the print cartridge from the printer.

2. To redistribute the toner, gently rock the print cartridge from front to back.

/A CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.

3. Reinsert the print cartridge into the printer, and close the print cartridge door. If the print is still light
or unacceptable, install a new print cartridge.

Replace supplies

Print cartridge

1. Open the print-cartridge door.
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Grasp the handle on the print cartridge and then pull the cartridge straight out to remove it. See
the recycling information inside the print cartridge box.
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Remove the new print cartridge from its packaging, remove the orange cover from the print
cartridge, and then pull the orange tab straight out to remove the sealing tape.
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6. Close the print-cartridge door.

/A CAUTION: Iftoner gets on any clothing, wipe it off with a dry cloth and wash the clothing in cold water.
Hot water sets toner into the fabric.

Clean the product

Clean the paper path

During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these types of problems.

Specks Smearing
- AaBbGC AaBbCc
AgBbCc AcBhc
AaBbCc, AaBKCc
AdBbCc AcBLCc
AaBbCcC. AaBbCc

1.  Press Setup.
Use the arrow buttons to find the Service menu, and then press OK.

Use the arrow buttons to find Cleaning mode, and then press OK.

> «@ DN

Load plain letter or A4 paper when you are prompted.
5. Press OK again to confirm and begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.

Clean the lid backing

Minor debris can accumulate on the white document lid backing that is located underneath the product
lid.

1. Turn off the product, unplug the power cord, and raise the lid.
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2. Clean the white document lid backing by using a soft cloth or sponge that has been moistened with
a mild soap and warm water. Wash the backing gently to loosen debris; do not scrub the backing.

3. Dry the backing by using a chamois or soft cloth.

/A CAUTION: Do not use paper-based wipes because they might scratch the backing.

4. If this does not clean the backing well enough, repeat the previous steps and use isopropyl alcohol
to dampen the cloth or sponge, and then wipe the backing thoroughly with a damp cloth to remove
any residual alcohol.

Clean the exterior

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the product.

Firmware updates

Firmware updates and installation instructions for this product are available at www.hp.com/support/
LJM1120. Click Downloads and drivers, click the operating system, and then select the firmware
download for the product.

Bf NOTE: In certain areas of California, air pollution control regulations restrict the use of liquid
Isopropyl Alcohol (IPA) as a cleaning agent. In those areas of California, please disregard the
previous recommendations and use a dry, lint-free cloth. The cloth may be moistened with water
if desired.
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Problem-solving checklist

Follow these steps when trying to solve a problem with the product.

Step Verification step Possible problems Solutions
number
1 Is the power on? No power due to failed power source, cable, 1. Verify that the product is plugged in.
switch, or fuse.
2. Verify that the power cable is functional
and that the power switch is on.
3. Check the power source by plugging
the product directly into the wall or into
a different outlet.
2 Does Ready appear in the Control panel shows an error. See Control-panel messages on page 80
product control panel? for a list of common messages that will help
you correct the error.
The control panel should
function without error
messages.
3 Do information pages print? An error message appears on the control- See Control-panel messages on page 80
panel display. for a list of common messages that will help
Print a configuration page. you correct the error.
Paper jams when printing. Make sure that media that meets
HP specifications.
Clean the paper path. See Clean the paper
path on page 75.
4 Does the product copy? Paper jams when printing. Make sure that media that meets
HP specifications.
Place the configuration page
onto the flatbed scanner and Clean the paper path. See Clean the paper
make a copy. The copies path on page 75.
should print without print-
quality problems. Poor copy quality from the flatbed. 1. Clean the flatbed glass. See Clean the
scanner glass on page 65.
2. If, after performing the maintenance,
the problem persists, see Copy
problems on page 96.
5 Does the product print from  Software is not installed correctly or an error  Uninstall and then reinstall the product

the computer?

Use a word-processing
program to send a print job to
the product.

occurred during software installation.

software. Verify that you are using the
correct installation procedure and the
correct port setting.

The cable is not connected correctly.

Reconnect the cable.

An incorrect driver is selected.

Select the proper driver.

There is a port driver problem in Microsoft
Windows.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.
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Step Verification step Possible problems Solutions
number
6 Does the product scan to the The cable is not connected correctly. Reconnect the cable.
computer?
Software is not installed correctly or an error  Uninstall and then reinstall the product
Initiate a scan from the basic ~ occurred during software installation. software. Verify that you are using the
desktop software at your correct installation procedure and the
computer. correct port setting.
If the error persists, turn off the product and then turn on the product.
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Control-panel messages

The majority of the control-panel messages are intended to guide the user through typical operation.
The control-panel messages indicate the status of the current operation, and include a page count on
the second line of the display, if appropriate. When the product is receiving print data or scanning
commands, control-panel messages indicate this status. In addition, alert messages, warning
messages, and critical error messages indicate situations that might require some action.

Alert and warning messages

Alert and warning messages appear temporarily and might require the user to acknowledge the
message by pressing OK to resume or by pressing Cancel to cancel the job. With certain warnings, the
job might not complete or the print quality might be affected. If the alert or warning message is related
to printing and the auto-continue feature is on, the product will attempt to resume the printing job after
the warning has appeared for 10 seconds without acknowledgement.

Alert and warning message tables

Control panel message

Description

Recommended action

Device error

Press [OK]

The product experienced an internal
communication error.

This is a warning message only. Job output
might be affected.

Jam in print paper path
alternates with

Open door and clear jam

The product has detected a jam in the paper
path.

Clear the jam from the area indicated on the
product control panel, and then follow the
control-panel instructions. See Clear jams
on page 83.

Page too complex

The product could not print the current page
because of its complexity.

Press OK to clear the message.

Press [OK] Allow the product to finish the job, or press
Cancel to cancel the job.
Printer jam The product has detected a jam in the input  Clear the jam from the area indicated on the

clear paper path

trays.

product control panel, and then follow the
control panel instructions. See Clear jams

on page 83.

Settings cleared

The product has cleared job settings.

Re-enter any appropriate job settings.
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Critical error messages

Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

Critical error message-tables

Control panel message

Description

Recommended action

50.1 Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

1. Turn off the power by using the power
switch, and then wait at least 30
seconds.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Turn on the power and wait for the
product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

50.2 Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

50.3 Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

50.8 Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

50.9 Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
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Control panel message

Description

Recommended action

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

52 Scanner Error

Turn off then on

The product has experienced a scanner
error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

54.1C Error

Turn off then on

The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.

If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

Engine comm. Error

The product has experienced an internal
hardware error.

1. Turn off the power by using the power
switch, and then wait at least 30
seconds.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Turn on the power and wait for the
product to initialize.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.
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Control-panel display problems

/A CAUTION: Static electricity can cause unexpected black lines or dots to appear on the product control-
panel display. Do not touch the product control-panel display if there is a chance that you have collected
a static electric charge (for example, by walking on carpet in a low-humidity environment).

Unexpected lines or dots might appear on the product control-panel display, or the display might become
blank if the product is exposed to an electric or magnetic field. To resolve this problem, perform the
following procedure:

1. Turn the product off.
2.  Remove the product from the electric or magnetic field.
3. Turn the product on again.

Clear jams

Causes of jams

ENWW

Occasionally, paper or other print media can become jammed during a print job. Some causes include
the following events:

The input trays are loaded improperly or overfilled, or the media guides are not set properly.

Media is added to or removed from an input tray during a print job or an input tray is removed from
the product during a print job.

The cartridge door is opened during a print job.

Too many sheets have accumulated in an output area, or sheets are blocking an output area.
The print media that is being used does not meet HP specifications.

The media is damaged or has foreign objects attached to it, such as staples or paper clips.

The environment in which the print media was stored is too humid or too dry.
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Where to look for jams

Jams can occur in these locations:
e Ininput areas

e Inoutput areas

e In the print-cartridge area

Find and remove the jam by using the instructions on the following pages. If the location of the jam is
not obvious, first look inside the product.

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.

Clear jams from the input-tray areas

/A CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

B NOTE: Depending on where the jam is located, some of the following steps might not be necessary.

1. Open the print-cartridge door.
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3. With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

5. With both hands, grasp the side of the jammed media that is most visible (this includes the middle),
and carefully pull it free from the product.
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Replace the print cartridge and close the print-cartridge door.

6.
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Clear jams from the output bin

/A CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

With both hands, grasp the side of the jammed media that is most visible (this includes the middle), and
carefully pull it free from the product.
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Clear jams from the print-cartridge area

/A CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

1. Open the print-cartridge door, and remove the print cartridge.
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/A CAUTION: To prevent damage to the print cartridge, minimize its exposure to direct light.

2. With both hands, grasp the side of the jammed media that is most visible (this includes the middle),
and carefully pull it free from the product.

3.
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Avoid repeated jams

ENWW

Verify that the input tray is not overfilled. The input tray capacity varies depending on the type of
print media that you are using.

Verify that the media guides are properly adjusted.

Check that the input tray is securely in place.

Do not add print media into the input tray while the product is printing.
Use only HP-recommended media types and sizes.

Do not fan media prior to loading it in a tray. To loosen the ream, hold it firmly in both hands and
twist the media by rotating your hands in the opposite direction.

Do not let print media stack up in the output bin. The print media type and the amount of toner used
affect the output bin capacity.

Check the power connection. Make sure that the power cord is firmly connected to both the product
and the power supply box. Plug the power cord into a grounded power outlet.
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Solve image-quality problems

Print problems

Print quality problems

Occasionally, you might encounter problems with print quality. The information in the following sections
helps you identify and resolve these issues.

General print-quality issues

The following examples depict letter-size paper that has passed through the product short-edge-first.
These examples illustrate problems that would affect all of the pages that you print. The topics that follow
list the typical cause and solution for each of these examples.

Problem

Cause

Solution

Print is light or faded.

Aa Cc
Aa ' Cc
Aa Cc
Aa ' Cc
Aa ' Cc

The media might not meet HP specifications.

Use media that meets HP specifications.

The print cartridge might be defective. If you
use a non-HP print cartridge, no messages
appear on the product control panel.

Replace the print cartridge. See Print
cartridge on page 73.

If the print cartridge is not low or empty,
inspect the toner roller to see if the roller is
damaged. If it is, replace the print cartridge.

If the whole page is light, the print density
adjustment is too light or EconoMode might
be turned on.

Adjust the print density, and disable
EconoMode in the product Properties.

Toner specks appear.

' AaBbGc
AcBBGE
AaBbCc.
AaBbCc
AaBbCc.

The media might not meet HP specifications.

Use media that meets HP specifications.

The paper path might need cleaning.

Clean the paper path. See Clean the paper
path on page 75.

Dropouts appear.

AaBbCc
AaBbCc
AasbCc
AaRpLCc
AnBHCc

A single sheet of print media might be
defective.

Try reprinting the job.

The moisture content of the paper is uneven
or the paper has moist spots on its surface.

The paper lot is flawed. The manufacturing
processes can cause some areas to reject
toner.

Try different paper, such as high-quality
paper that is intended for laser printers.

The print cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 73.

If the error persists, contact HP. See
www.hp.com/support/LJM1120 or the
support flyer that came in the product box.

Vertical streaks or bands appear
on the page.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel.

Replace the print cartridge. See Print
cartridge on page 73.
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Problem

Cause

Solution

AC
Ab\(
AC
AC
AC

B> Za
Bt Ca
B> Zg
B> Za
B> ZQ@

The amount of background toner
shading becomes unacceptable.

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

The media might not meet HP specifications.

Use a different paper with a lighter basis
weight. See Paper and print media
on page 31.

The priority input tray might be installed
incorrectly.

Make sure that the priority input tray is in
place.

The print-density setting is too high.

Decrease the print-density setting through
the print driver. This decreases the amount
of background shading.

Very dry (low humidity) conditions can
increase the amount of background shading.

Check the product environment.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel.

Replace the print cartridge. See Print
cartridge on page 73.

Toner smears appear on the
media.

AaBbCc
AaBhlc
AaBhCc
AaBLCc
AaBbCc

The media might not meet HP specifications.

Use media that meets HP specifications.

If toner smears appear on the leading edge
of the paper, the media guides are dirty, or
debris has accumulated in the print path.

Clean the media guides and the paper path.
See Clean the paper path on page 75.

The fuser temperature might be too low.

In the printer driver, make sure the
appropriate media type is selected.

Use the archive print feature to improve
toner fusing. See Archive print on page 49.

The toner smears easily when
touched.

AaBbCc
B
Al
AaBbCc
AaBbCc

The product is not set to print on the type of
media on which you want to print.

In the printer driver, select the Paper/
Quality tab and set Paper Type to match
the type of media on which you are printing.
Print speed might be slower if you are using
heavy paper.

The media might not meet HP specifications.

Use media that meets HP specifications.

The paper path might need cleaning.

Clean the paper path. See Clean the paper
path on page 75.

The power source might be defective.

Plug the product directly into an AC outlet
instead of into a power strip.

The fuser temperature might be too low.

Use the archive print feature to improve
toner fusing. See Archive print on page 49.
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Problem

Cause

Solution

Marks repeatedly appear at even

intervals on the page.

AaBbCc’[™
AoBch‘
AaBoCc'|™
AaBbCc,
AGBDbCC

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure that the
appropriate media type is selected. Print
speed might be slower if you are using
heavy paper.

Internal parts might have toner on them.

The problem typically corrects itself after a
few more pages.

The paper path might need cleaning.

Clean the paper path. See Clean the paper
path on page 75.

The print cartridge might be damaged.

If a repetitive mark occurs at the same spot
on the page, install a new HP print cartridge.
See Print cartridge on page 73.

The printed page contains
misformed characters.

AaBlCc
AaoBpCc
AaBbCc
AaBloCc
AaBloCc
AaBloCc

The media might not meet HP specifications.

Use a different paper, such as high-quality
paper that is intended for laser printers.

If characters are incorrectly formed so that
they produce a wavy effect, the laser scanner
might need service.

Verify that the problem also occurs on the
configuration page. If so, contact HP. See
www.hp.com/support/LJM1120 or the

support flyer that came in the product box.

The printed page is curled or
wavy.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure the
appropriate media type is selected.

If the problem persists, select a media type
that uses a lower fuser temperature, such
as transparencies or light media.

The media might have been in the input tray
too long.

Turn over the stack of media in the tray.
Also, try rotating the media 180° in the input
tray.

The media might not meet HP specifications.

Use a different paper, such as high-quality
paper that is intended for laser printers.

Both high temperature and humidity can
cause paper curl.

Check the product environment.

Text or graphics are skewed on

the printed page.

The media might be loaded incorrectly or the
input tray might be too full.

Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 35.

The media might not meet HP specifications.

Use a different paper, such as high-quality
paper that is intended for laser printers.
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Problem

Cause

Solution

The printed page contains
wrinkles or creases.

AaBbCc

The media might be loaded incorrectly or the
input tray might be too full.

Turn over the stack of paper in the input tray,
or try rotating the paper 180° in the input
tray.

Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 35.

The media might not meet HP specifications.

Use a different paper, such as high-quality
paper that is intended for laser printers.

Air pockets inside envelopes can cause them
to wrinkle.

Remove the envelope, flatten it, and try
printing again.

Toner appears around the printed

characters.

The media might be loaded incorrectly.

Turn over the stack of paper in the tray.

If large amounts of toner have scattered
around the characters, the paper might have
high resistivity.

Use a different paper, such as high-quality
paper that is intended for laser printers.

An image that appears at the top  Software settings might affect image
of the page (in solid black) repeats  printing.

farther down the page (in a gray

field).

In your software program, change the tone
(darkness) of the field in which the repeated
image appears.

In your software program, rotate the whole
page 180° to print the lighter image first.

AaBbCc

The order of images printed might affect
printing.

Change the order in which the images are
printed. For example, have the lighterimage
at the top of the page, and the darker image
farther down the page.

A power surge might have affected the
product.

If the defect occurs later in a print job, turn
the product off for 10 minutes, and then turn
on the product to restart the print job.

Media-handling problems

Use the information in this section when the product experiences media-handling problems.

Print-media guidelines

e For best results, make sure that the paper is of good quality, and free of cuts, nicks, tears, spots,
loose particles, dust, wrinkles, voids, staples, and curled or bent edges.

e  For best-quality printing, use a smooth type of paper. Generally, smoother media produces better
results. .

e If you are unsure what type of paper you are loading (such as bond or recycled), check the label
on the package of paper.
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e Do not use media that is designed for inkjet printers only. Use media that is designed for laser

printers.

e Do not use letterhead paper that is printed with low-temperature inks, such as those used in some
types of thermography.

° Do not use raised or embossed letterhead.

e The product uses heat and pressure to fuse toner to the paper. Make sure that any colored paper
or preprinted forms use inks that are compatible with this fusing temperature (200°C or 392°F for

0.1 second).

A CAUTION:

Failure to follow these guidelines could cause jams or damage to the product.

Solve print-media problems

The following problems with media cause print-quality deviations, jamming, or even damage to the

product.

Problem

Cause

Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy or
too smooth, or it is embossed or from a faulty
paper lot.

Try another kind of paper, between 100 and
250 Sheffield, with 4 to 6% moisture content.

Dropouts, jamming, or curl

The paper has been stored incorrectly.

Store paper flat in its moisture-proof wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

Excessive curl

The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Use long-grain paper.

The paper varies from side-to-side.

Turn the paper over.

High fuser temperature is curling the paper.

Turn on the Less paper curl setting.

At the control panel, press Setup, use the
arrow buttons to select Service, and then press
OK. Use the arrow buttons to select Less paper
curl, press OK, use the arrow buttons to select
On, and then press OK.

Jamming, damage to
product

The paper has cutouts or perforations.

Use paper that is free of cutouts or
perforations.

Problems with feeding

The paper has ragged edges.

Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side.

Turn the paper over.

The paper is too moist, too rough, too heavy or
too smooth, has the wrong grain direction, or is
of short-grain construction or it is embossed or
from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Use long-grain paper.

Print is skewed (crooked).

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the media
in the input tray again. Adjust the media guides
to the width and length of the media that you
are using and try printing again.
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Problem

Cause

Solution

More than one sheet feeds at
one time.

The media tray might be overloaded.

Remove all media from the tray, and then
return some of the media to the tray. See Load
paper and print media on page 35.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded, or
damaged. Try printing on media from a new or
different package.

The media might have been fanned before it
was loaded.

Load media that was not fanned. Loosen ream
by twisting paper stack.

Media might be too dry.

Load new paper that was stored properly.

The product does not pull
media from the media input
tray.

The product might be in manual feed mode.

e If Manual feed appears on the product
control-panel display, press OK to print
the job.

e  Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged.

Contact HP. See www.hp.com/support/
LJM1120 or the support flyer that came in the
product box.

The paper-length adjustment control in tray 1
is set at a length that is greater than the media
size.

Adjust the paper-length adjustment control to
the correct length.

Performance problems

ENWW

Try the tips in this section if pages exit the product, but have nothing printed on them, or when the product

does not print any pages.

Problem

Cause

Solution

Pages print but are totally
blank.

The sealing tape might still be in the print
cartridge.

Verify that the sealing tape has been
completely removed from the print cartridge.

The document might contain blank pages.

Check the document that you are printing to
see if content appears on all of the pages.

The product might be malfunctioning.

To check the product, print a configuration
page.

Certain media types can slow the print job.

Print on a different type of media.
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Problem

Cause

Solution

Pages did not print.

The product might not be pulling media
correctly.

See Media-handling problems on page 93.

The media might be jamming in the product.

Clear the jam. See Clear jams on page 83.

The USB cable or the network cable might be
defective or incorrectly connected.

o Disconnect the cable at both ends and
reconnect it.

e  Try printing a job that has printed in the
past.

e  Try using a different USB or network
cable.

The product IP address might have been
changed.

From the control panel, print a configuration
page. Confirm the IP address with that listed in
the Properties dialog box.

The product might not be set up as the default
printer.

Open the Printers or Printers and Faxes
dialog box, right click the product, and then
click Set as Default Printer.

The product might have encountered an error.

Check the control panel for an error message.
See Control-panel messages on page 80.

The product might be paused or offline.

Open the Printers or Printers and Faxes
dialog box, and verify that the product status is
Ready. If it is Paused, right-click the product
and click Resume Printing.

The product might not be receiving power.

Check the power cord and verify that the
product is turned on.

Other products are running on your computer.

The product might not share a USB port. If you
have an external hard drive or network
switchbox that is connected to the same port
as the product, the other device might be
interfering. To connect and use the product,
disconnect the other device or use two USB
ports on the computer.

Copy problems

Prevent copy problems

The following are a few simple steps you can take to improve copy quality:

e Use quality originals.

e Load the media correctly. If the media is loaded incorrectly, it might skew, causing unclear images
and problems with the OCR program. See Load paper and print media on page 35 for instructions.

e Use or make a carrier sheet to protect your originals.

Bf NOTE: Verify that the media meets HP specifications. If the media meets HP specifications, recurring
feed problems indicate the pickup roller or separation pad is worn. Contact HP. See www.hp.com/
support/LJM1120 or the support flyer that came in the product box.
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Image problems

Problem

Cause

Solution

Images are missing or faded.

The print-cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 73.

The original might be of poor quality.

If your original is too light or damaged, the
copy might not be able to compensate, even
if you adjust the contrast. If possible, find an
original document in better condition.

The contrast settings might be set
incorrectly.

Use the control-panel Lighter/Darker button
to change the contrast setting.

The original might have a colored
background.

Colored backgrounds might cause images in
the foreground to blend into the background,
or the background might appear in a
different shade. If possible, use an original
document without a colored background.

Vertical white or faded stripes
appear on the copy.

Aa
Aa
Aa
Aa
Aa

Cc
Cc
Cc
Cc
Cc

The media might not meet
HP specifications.

Use media that meets HP specifications.

The print-cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 73.

Unwanted lines appear on the
copy.

AcBH(Ca
AcIBb(Ca
AcB(Ca
AcIBI(Ca
AcBb(Za

The flatbed scanner might be dirty.

Clean the flatbed scanner. See Clean the
scanner glass on page 65.

The photosensitive drum inside the print
cartridge might have been scratched.

Install a new HP print cartridge. See Print
cartridge on page 73.

Black dots or streaks appear on
the copy.

Ink, glue, correction fluid, or an unwanted
substance might be on the flatbed scanner.

Clean the flatbed scanner. See Clean the
scanner glass on page 65.

The power to the product might have
fluctuated.

Reprint the job.

Copies are too light or dark.

The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.

See the product software Help for more
information about changing the settings.

Text is unclear.

The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.
Verify that the EconoMode setting is off.

See the product software Help for more
information about changing the settings.
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Media-handling problems

Problem

Cause

Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy
or too smooth, or it is embossed or from a
faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Dropouts, jamming, or curl

The paper has been stored incorrectly.

Store paper flat in its moisture-proof
wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

Excessive curl

The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Use long-grain paper.

The paper varies from side-to-side.

Turn the paper over.

Jamming, damage to paper

The paper has cutouts or perforations.

Use paper that is free of cutouts or
perforations.

Problems with feeding

The paper has ragged edges.

Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side.

Turn the paper over.

The paper is too moist, too rough, too heavy
or too smooth, has the wrong grain direction,
or is of short-grain construction or it is
embossed or from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Use long-grain paper.

Print is skewed (crooked).

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the
media in the input tray again. Adjust the
media guides to the width and length of the
media that you are using and try printing
again.

More than one sheet feeds at one
time.

The media tray might be overloaded.

Remove some of the media from the tray.
See Load paper and print media
on page 35.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded,
or damaged. Try printing on media from a
new or different package.

The product does not pull media
from the media input tray.

The product might be in manual feed mode.

° If Manual appears on the product
control-panel display, press OK to print
the job.

e  Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged.

Contact HP. See www.hp.com/support/
LJM1120 or the support flyer that came in
the product box.

The paper-length adjustment control in
tray 1 is set at a length that is greater than
the media size.

Adjust the paper-length adjustment control
to the correct length.
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Performance problems
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Problem

Cause

Solution

No copy came out.

The input tray might be empty.

Load media in the product. See Load paper
and print media on page 35 for more
information.

The original might have been loaded
incorrectly.

On the flatbed scanner, place the original
document face-down with the upper-left
corner of the document at the corner of the
glass indicated by the icon on the scanner.

Copies are blank.

The sealing tape might not have been
removed from the print cartridge.

Remove the print cartridge from the product,
pull out the sealing tape, and reinstall the
print cartridge.

The original might have been loaded
incorrectly.

On the flatbed scanner, make sure that the
original document is placed face-down with
the upper-left corner of the document at the
corner of the glass indicated by the icon on
the scanner.

The media might not meet
HP specifications.

Use media that meets HP specifications.

The print cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 73.

Copies are reduced in size.

The product settings might be set to reduce
the scanned image.

On the control panel, press Reduce/
Enlarge and verify that it is set to
Original=100%.
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Scan problems

Solve scanned-image problems

Problem

Cause

Solution

The scanned image is of poor
quality.

The original might be a second-generation
photo or picture.

e To eliminate the patterns, try reducing
the size of the image after scanning.

e  Print the scanned image to see if the
quality is better.

e  Verify that the resolution settings are
correct for the type of scan job that you
are performing. See Scanner
resolution and color on page 64.

The image that appears on the screen might
not be an accurate representation of the
quality of the scan.

e  Try adjusting your computer monitor
settings to use more colors (or levels of
gray). Typically, you make this
adjustment by opening Display in
Windows Control Panel.

e  Try adjusting the resolution settings in
the scanner software. See Scanner
resolution and color on page 64.

The original might have been loaded
incorrectly.

Verify that the original is loaded correctly on
the flatbed scanner. See Load paper and
print media on page 35.

The scanner might be dirty.

Clean the scanner. See Clean the scanner
glass on page 65.

The graphics settings might not be suitable
for the type of scan job that you are
performing.

Try changing the graphics settings. See
Scanner resolution and color on page 64.

Part of the image did not scan.

The original might have been loaded
incorrectly.

Verify that the original is loaded correctly on
the flatbed scanner. See Load originals for
scanning on page 62.

A colored background might be causing
images in the foreground to blend into the
background.

Try adjusting the settings before you scan
the original or enhancing the image after you
scan the original.

The original is too small.

The minimum size that the flatbed scanner
supports is 25 x 25 mm (1 x 1 inch).

The media size is incorrect.

In Scan settings, make sure that the input
media size is large enough for the document
that you are scanning. .
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Problem

Cause

Solution

The scan takes too long

The resolution or color level is set too high.

Change the resolution and color settings to
the correct settings for your job. See
Scanner resolution and color on page 64.

The software is set to scan in color.

The system default is color, which takes
longer to scan even when scanning a
monochrome original. If you acquire an
image through TWAIN or WIA, you can
change the settings so that the original
scans in grayscale or black-and-white. See
the product software Help for details.

A print job or copy job was sent before you
tried to scan.

If someone sent a print job or copy job before
you tried to scan, the scan will start if the
scanner is not busy. However, because the
product and scanner share memory, the
scan might be slower.
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Scan-quality problems

Prevent scan-quality problems

The following are a few simple steps you can take to improve copy and scan quality.

e Use high-quality originals.

e Load the media correctly. If the media is loaded incorrectly, it might skew, which causes unclear
images. See Load paper and print media on page 35 for instructions.

e Adjust the software settings according to how you plan to use the scanned page. See Scanner
resolution and color on page 64 for more information.

e If your product frequently feeds more than one page at a time, the separation pad might need to
be replaced. Contact HP. See www.hp.com/support/LJM1120 or the support flyer that came in the

product box.

e Use or make a carrier sheet to protect your originals.

Solve scan-quality problems

Problem

Cause

Solution

Blank pages

The original might have been loaded upside
down.

On the flatbed scanner, place the original
document face-down with the upper-left
corner of the document at the corner of the
glass indicated by the icon on the scanner.

Too light or dark

The resolution and color levels may be set
incorrectly.

Verify that you have the correct resolution
and color settings. See Scanner resolution
and color on page 64.

Unwanted lines

Ink, glue, correction fluid, or an unwanted
substance might be on the glass.

Clean the flatbed scanner surface. See
Clean the scanner glass on page 65.

Black dots or streaks

Ink, glue, correction fluid, or an unwanted
substance might be on the glass.

Clean the flatbed scanner surface. See
Clean the scanner glass on page 65.

The power to the product might have
fluctuated.

Reprint the job.

Unclear text

The resolution levels might be set
incorrectly.

Verify that the correct resolution settings are
correct. See Scanner resolution and color

on page 64.

Optimize and improve image quality

Print-quality checklist

General print-quality problems can be solved by using the following checklist:

1. Make sure that the paper or print media that you are using meets specifications. Generally,
smoother paper provides better results.

2. Ifyou are using a special print media such as labels, transparencies, glossy, or letterhead, ensure
that you have printed by type. See Change the print driver to match the media type and size

on page 38.
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3. Print a configuration page at the product control panel. If the page does not print correctly, the
problem is with the hardware. Contact HP. See www.hp.com/support/LJM1120 or the support flyer
that came in the product box.

4. Print a demo page at the control panel. If the page prints, the problem is with the printer driver. Try
printing from another printer driver.

5. Try printing from a different program. If the page prints correctly, the problem is with the program
from which you were printing.

6. Restart the computer and the product, and then try printing again. If the problem is not resolved,
see General print-quality issues on page 90.
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Solve connectivity problems

Solve direct-connection problems

If the product is experiencing connection issues while directly connected to a computer, complete the
following steps:

1. Make sure that USB cable is no longer than 3 meters (9 feet).
2. Make sure that both ends of the USB cable are connected.
3. Make sure that the cable is a USB 2.0 Hi-Speed-certified cable.

4. If the error persists, use a different USB cable.

Network problems (network models only)

Verify that the product is on and online
Check the following items to make sure the product is ready to print.
1. Is the product plugged in and turned on?

Make sure that the product is plugged in and turned on. If the problem persists, you might have a
defective power cable, power source, or product.

2. s the product in Ready mode?

If the product is finishing a job, you might need to wait until the current job is completed.
3. Is the product control-panel display blank?

e  Make sure the product is turned on.

e  Make sure the product is installed correctly.
4. Does a message other than Ready appear on the product control-panel display?

e  See your product documentation for a complete list of control panel messages and corrective
actions.

Resolve communication problems with the network
Check the following items to verify that the product is communicating with the network.
1. Arethere any physical connection problems between the workstation or file server and the product?

Verify that the network cabling, connections, and router configurations are correct. Verify that the
network cable lengths meet network specifications.

2. Are the network cables connected properly?

Make sure that the product is attached to the network using the appropriate port and cable. Check
each cable connection to make sure it is secure and in the right place. If the problem continues,
try a different cable or ports on the hub or transceiver. The amber activity light and the green link
status light next to the port connection on the back of the product should be lit.

3. Can you "ping" the product IP address?
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Use the command prompt to ping the product from the computer. For example:
ping 192.168.45.39
Ensure that the ping displays round-trip times.

If you are able to ping the product, verify that the IP address configuration for the product is correct
on the computer. If it is correct, delete and then add the product again.

If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

4. Have any software programs been added to the network?
Make sure they are compatible and that they are installed correctly with the correct printer drivers.
5. Are other users able to print?

The problem may be workstation-specific. Check the workstation network drivers, printer drivers,
and redirection.

6. If other users are able to print, are they using the same network operating system?

Check your system for proper network operating system setup.
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Solve software problems

Solve common Windows problems

Error message:
"General Protection FaultException OE"
"Spool32"

"lllegal Operation™

Cause

Solution

Close all software programs, restart Windows, and try again.

Select a different printer driver. If the device PCL 6 printer
driver is selected, switch to the PCL 5 or HP postscript level 3
emulation printer driver, which can be done from a software
program.

Delete all temp files from the Temp subdirectory. Determine
the name of the directory by opening the AUTOEXEC.BAT file
and looking for the statement "Set Temp =". The name after
this statement is the Temp directory. It is usually C\TEMP by
default, but can be redefined.

See the Microsoft Windows documentation that came with the
computer for more information about Windows error
messages.

Solve common Macintosh problems

Table 11-1 Problems with Mac OS X v10.3 and Mac OS X v10.4

The product name, IP address, or “Rendezvous” or “Bonjour” host name does not appear in the printer list box in the Printer Setup

Utility.

Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong product name, IP address, or "Rendezvous" or "Bonjour"
host name is being used.

Check the product name, IP address, or "Rendezvous" or "Bonjour"
host name by printing a configuration page. Verify that the name, IP
address, or "Rendezvous" or "Bonjour" host name on the
configuration page matches the product name, IP address, or
"Rendezvous" or "Bonjour" host name in the Printer Setup Utility.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.
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Table 11-1 Problems with Mac OS X v10.3 and Mac OS X v10.4 (continued)

A print job was not sent to the product that you wanted.

Cause

Solution

The print queue might be stopped.

Open the print queue, and then click Start Jobs.

The wrong product name or IP address is being used. Another
product with the same or similar name, IP address, or "Rendezvous"
or "Bonjour" host name might have received your print job.

Check the product name, IP address, or "Rendezvous" or "Bonjour"
host name by printing a configuration page. Verify that the name, IP
address, or "Rendezvous" or "Bonjour" host name on the
configuration page matches the product name, IP address, or
"Rendezvous" or "Bonjour" host name in the Printer Setup Utility.

An encapsulated PostScript (EPS) file does not print with the correct fonts.

Cause

Solution

This problem occurs with some programs.

e Try downloading the fonts that are contained in the EPS file to
the product before printing.

e  Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause

Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

When connected with a USB cable, the product does not appear in the Macintosh Printer Setup Utility after the driver is selected.

Cause

Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting
e  Check that your Macintosh supports USB.

e  Verify that your Macintosh operating system is Mac OS X v10.3
or Mac OS X v10.4.

e  Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting

e  Check that the product is turned on.

e  Verify that the USB cable is connected correctly.

e  Checkthatyou are using the appropriate high-speed USB cable.

e  Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host

computer.

e  Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
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Table 11-1 Problems with Mac OS X v10.3 and Mac OS X v10.4 (continued)

When connected with a USB cable, the product does not appear in the Macintosh Printer Setup Utility after the driver is selected.

Cause Solution

from the chain and connect the cable directly to the USB port on
the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.
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A Accessories and ordering information

e To order supplies in the U.S., go to www.hp.com/sbso/product/supplies.

e  To order supplies worldwide, go to www.hp.com/ghp/buyonline.html.

e To order supplies in Canada, go to www.hp.ca/catalog/supplies.

e To order supplies in Europe, go to www.hp.com/go/ljsupplies.

e To order supplies in Asia-Pacific, go to www.hp.com/paper/.

e To order accessories, go to www.hp.com/go/accessories.
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Supplies

Product name Description

Part number

Replacement print cartridge Average yield for the print cartridge is
approximately 2,000 pages.

CB436A

Cable and interface accessories

Product name Description Part number
USB cable 2-meter standard USB-compatible C6518A
device connector
3-meter standard USB-compatible C6520A

device connector
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B Service and support

Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet M1120 and M1120n One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials
and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects
during the warranty period, HP will, at its option, either repair or replace products which prove to be defective.
Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase,
for the period specified above, due to defects in material and workmanship when properly installed and used. If

HP receives notice of such defects during the warranty period, HP will replace software which does not execute

its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a
reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of
the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject to
incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b)
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation
outside of the published environmental specifications for the product, or (e) improper site preparation or
maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or
provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might
not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from
country/region to country/region, state to state, or province to province. HP's limited warranty is valid in any country/
region or locality where HP has a support presence for this product and where HP has marketed this product. The
level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function
of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory
reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR
SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL
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(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR
OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Customer self repair warranty service

HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Print cartridge limited warranty statement

ENWW

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP Customer Care

Online Services

For 24-hour access to updated HP device-specific software, product information, and support
information through an Internet connection, go to the Web site: www.hp.com/support/LJM1120.

HP Instant Support Professional Edition (ISPE) is a suite of Web-based troubleshooting tools for desktop
computing and printing products. Go to instantsupport.hp.com.

Telephone support

HP provides free telephone support during the warranty period. For the telephone number for your
country/region, see the flyer that shipped with the device, or visit www.hp.com/support/. Before calling
HP, have the following information ready: the product name and serial number, the date of purchase,
and a description of the problem.

Software utilities, drivers, and electronic information

www.hp.com/go/LJM1120 software

The Web page for the drivers is in English, but you can download the drivers themselves in several
languages.

HP direct ordering for accessories or supplies

° United States: www.hp.com/sbso/product/supplies.

° Canada: www.hp.ca/catalog/supplies

e  Europe: www.hp.com/go/ljsupplies

e Asia-Pacific: www.hp.com/paper/

To order genuine HP parts or accessories, go to the HP Parts Store at www.hp.com/buy/parts (U.S. and
Canada only), or call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Canada).

HP service information
To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 1-800-387-3867 (Canada).
Outside the United States and Canada, call the customer support number for your country/region. See
the flyer that shipped in the box with the device.

HP service agreements

Call 1-800-HPINVENT (1-800-474-6836 (U.S.)) or 1-800-268-1221 (Canada). Or, go to the HP
SupportPack and Carepagq™ Services Web site at www.hpexpress-services.com/10467a.

For extended service, call 1-800-446-0522.

HP support and information for Macintosh computers

Go to www.hp.com/go/macosx for Macintosh OS X support information and HP subscription service for
driver updates.
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Go to www.hp.com/go/mac-connect for products that are designed specifically for the Macintosh user.
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HP maintenance agreements

HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

Repacking the device

If HP Customer Care determines that your device needs to be returned to HP for repair, follow the steps
below to repack the device before shipping it.

/\ CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1.

A

Remove and retain the print cartridge.

CAUTION: Itis extremely important to remove the print cartridge before shipping the device. A
print cartridge that remains in the device during shipping will leak and entirely cover the device
engine and other parts with toner.

To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge
in its original packing material or so that it is not exposed to light.

Remove and retain the power cable, interface cable, and optional accessories.

If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

Inthe U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.

Extended warranty

HP Support provides coverage for the HP hardware product and all HP-supplied internal components.
The hardware maintenance covers a 1- to 3-year period from date of the HP product purchase. The
customer must purchase HP Support within the stated factory warranty. For more information, contact
the HP Customer Care Service and Support group.
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Specifications

This section contains the following information about the product:

Physical specifications

Electrical specifications

Power consumption

Environmental specifications

Acoustic emissions
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Physical specifications

Table C-1 Physical specifications

Product Height Depth Width Weight

HP LaserJet M1120 308 mm (12.1 inches) 363 mm (14.3 inches) 437 mm (17.2 inches) 8.2 kg (18.7 Ib)

HP LaserJet M1120n 308 mm (12.1 inches) 363 mm (14.3 inches) 437 mm (17.2 inches) 8.2 kg (18.7 Ib)

Electrical specifications

/A CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Table C-2 Electrical specifications

ltem 110-volt models 230-volt models
Power requirements 110 to 127 V (+/- 10%) 220 to 240 V (+/- 10%)

50 /60 Hz (+/- 2 Hz) 50 /60 Hz (+/- 2 Hz)
Rated current 49A 29A

Power consumption

Table C-3 Power consumption (average, in watts)’

Product model Printing? Copying? Ready/Sleep? Off
HP LaserJet M1120 420 W 420 W 5W <0.1W
HP LaserJet M1120n 420 W 420 W 8w <0.1W

1 Values are based on preliminary data. See www.hp.com/support/LJM1120 for current information.
2 Power reported is highest values measured using all standard voltages.

3 Instant on fuser technology.

4 Recovery time from Ready/Sleep to start of printing < 6 seconds.

5 Maximum heat dissipation for all models in Ready mode = 30 BTU/hour
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Environmental specifications

Table C-4 Environmental specifications’

Recommended Operating Storage
Temperature 15°t0 32.5° C 15°t0 32.5° C —20°to 40° C

(59° to 90.5° F) (59° to 90.5° F) (—4°to 104° F)
Relative humidity 10% to 80% 10% to 80% 95% or less

1 Values are subject to change.

Acoustic emissions

Table C-5 Acoustic emissions

Sound Power Level Declared per ISO 9296’
Printing (19 ppm) Lwaq = 6.6 Bels(A) [66 dB(A)]
Ready Inaudible

Sound Pressure Level - Bystander Position Declared per ISO 9296’
Printing (19 ppm) Loam = 53 dB(A)

Ready Inaudible

1 Values are based on preliminary data. See www.hp.com/support/LJM1120 for current information.
2 Configuration tested: HP LaserJet M1120 printing simplex using A4 paper at 19 ppm.
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This section contains the following regulatory information:

FCC compliance

Environmental product stewardship program

Declaration of conformity

Safety statements
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FCC compliance

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. Ifit is not installed and used in accordance with the instructions, it may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase separation between equipment and receiver.
e Connect equipment to an outlet on a circuit different from that to which the receiver is located.

e  Consult your dealer or an experienced radio/TV technician.

EE)

NOTE: Any changes or modifications to the printer that are not expressly approved by Hewlett-
Packard could void the user's authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production

This product generates no appreciable ozone gas (O5).

Power consumption

Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves
money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

http://www.hp.com/hpinfo/globalcitizenship/environment/productdesign/ecolabels.html

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use

This product’s duplex feature (two-sided printing) and N-up printing (multiple pages printed on one page)
capability can reduce paper usage and the resulting demands on natural resources.
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Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It's easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/

recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (two to eight cartridges)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape up to eight single boxes together using strapping or packaging tape (up to 70 Ibs).
3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

Shipping

ENWW

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
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package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Non-US returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
globalcitizenship/environment.

For more information
To obtain information about these environmental topics:
e  Product environmental profile sheet for this and many related HP products
e HP’s commitment to the environment

e HP’s environmental management system
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e HP’s end-of-life product return and recycling program
e Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment/index.html.
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Declaration of conformity

Declaration of Conformity
according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0604-03-rel.1.0
Manufacturer's Address: 11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet M1120 Series
Regulatory Model Number? BOISB-0604-03

Product Options: ALL

Print Cartridges: CB436A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 — Class B
EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC and
carries the CE-Marking accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).

Boise, Idaho , USA

August 2007
For regulatory topics only:

European Contact:  Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe,, Herrenberger Strasse 140, , D-71034, Boblingen, (FAX: +49-7031-14-3143)

USA Contact: Product Regulations Manager, Hewlett-Packard Company,, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, , (Phone:
208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

/A WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme a la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

EMI statement (Korea)

Ol JIDl= IHEECZ2 MIIESSES & JJIZA
FAXNAUNA=E 28 Z=XE0
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Laser statement for Finland
Luokan 1 laserlaite
Klass 1 Laser Apparat

HP Laserdet M1120, M1120n, laserkirjoitin on kayttajan kannalta turvallinen luokan 1 laserlaite.
Normaalissa kaytdssa kirjoittimen suojakotelointi estaa lasersateen paasyn laitteen ulkopuolelle.
Laitteen turvallisuusluokka on maaritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen kayttdminen muulla kuin kayttdohjeessa mainitulla tavalla saattaa altistaa kayttajan
turvallisuusluokan 1 ylittavalle nakymattémalle lasersateilylle.

VARNING !

Om apparaten anvands pa annat satt an i bruksanvisning specificerats, kan anvandaren utsattas for
osynlig laserstralning, som éverskrider gransen for laserklass 1.

HUOLTO

HP LaserJet M1120, M1120n - kirjoittimen sisélla ei ole kayttajan huollettavissa olevia kohteita. Laitteen
saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkild. Tallaiseksi huoltotoimenpiteeksi
ei katsota variainekasetin vaihtamista, paperiradan puhdistusta tai muita kayttajan kasikirjassa

lueteltuja, kayttajan tehtavaksi tarkoitettuja yllapitotoimia, jotka voidaan suorittaa ilman erikoistydkaluja.

VARO !

Mikali kirjoittimen suojakotelo avataan, olet alttina ndkymattémallelasersateilylle laitteen ollessa
toiminnassa. Alé katso sateeseen.

VARNING !

Om laserprinterns skyddshdlje 6ppnas da apparaten ar i funktion, utsattas anvandaren fér osynlig
laserstralning. Betrakta ej stralen. Tiedot laitteessa kaytettdvan laserdiodin sateilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.

Substances table (China)
RIERE L FER> M5 REREE ), EZNERMES
Table D-1 AEHEEVRE

-2 FEREYMRAAR
4 (Pb) R (Hg) % (Cd) R (Cr(VI)  ZWBK (PBB) Ziw Kk
(PBDE)

ITENS | & X 0 X X o] o]
£ EHA & X ¢] o o 0 o)
EHIER o ¢] 0 o 0 o)
BHNE o ¢] 0 o 0 o)
wReRal X o} 0 o] o} 0
BYHE X o] o] o] o} o}
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Glossary

browser Short for Web browser, a software program that is used to locate and open Web pages.

collate The process of printing a multiple-copy job in sets. When collate is selected, the product prints an entire
set before printing additional copies. Otherwise, the product prints the specified number of copies of one page
before printing the subsequent pages.

contrast The difference between the dark and light areas of an image. The lower the number value, the more
closely the shades resemble each other. The higher the number, the more the shades appear separate from each
other.

dots per inch (dpi) A measurement of resolution that is used for printing. Generally, more dots per inch result
in a higher resolution, more visible detail in the image, and a larger file size.

DSL Digital subscriber line, a technology that enables a high-speed, direct connection to the Internet through
telephone lines.

e-mail (electronic mail) An abbreviation for electronic mail. Software that can be used to electronically transmit
items over a communications network.

file format The way the contents of a file are structured by a program or group of programs.

grayscale Shades of gray that represent light and dark portions of an image when color images are converted
to grayscale; colors are represented by various shades of gray.

halftone Animage type that simulates grayscale by varying the number of dots. Highly colored areas consist of
a large number of dots, while lighter areas consist of a smaller number of dots.

HP Director A software program that is used when working with documents on a Macintosh computer.

link A connection to a program or device that can be used to send information from the product software to other
programs, such as e-mail, electronic fax, and OCR links.

optical character recognition (OCR) software OCR software converts an electronic image of text, such as a
scanned document, into a form that word processor, spreadsheet, and database programs can use.

pixels per inch (ppi) A measurement of resolution that is used for scanning. Generally, more pixels per inch
result in a higher resolution, more visible detail in the image, and a larger file size.

printer driver A printer driver is a program that software programs use to gain access to a product’s features.
A printer driver translates a software program’s formatting commands (such as page breaks and font selection)
into a printer language (such as PostScript or PCL), and then sends the print file to the product.

Readiris An optical character recognition (OCR) program that was developed by I.R.I.S. and that is included
with the product software.

resolution The sharpness of an image, measured in dots per inch (dpi). The higher the dpi, the greater the
resolution.
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surge protector A device that protects a power supply and communications lines from electrical surges.

TWAIN An industry standard for scanners and software. By using a TWAIN-compliant scanner with a TWAIN-
compliant program, a scan can be initiated from within the program.

URL Uniform resource locator, the global address of documents and resources on the Internet. The first part of
the address indicates what protocol to use, the second part specifies the IP address or the domain name where
the resource is located.

USB Universal serial bus (USB) is a standard that was developed by the USB Implementers Forum, Inc., to
connect computers and peripherals. USB is designed to concurrently connect a single computer USB port to
multiple peripherals.

watermarks A watermark adds background text to a document that is being printed. For example, “Confidential”
can be printed in the background text of a document to indicate that the document is confidential. A selection can
be made from a set of predefined watermarks, and the font, size, angle, and style can be changed. The product
can place the watermark on the first page only or all pages.

WIA Windows Imaging Architecture (WIA) is an imaging architecture that is available in Windows Me and
Windows XP. A scan can be initiated from within these operating systems by using a WIA-compliant scanner.
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Index

A
accessibility features 3
accessories

part numbers 110
acoustic emissions 119
advanced software installation 6
alert messages 80
authorized dealers 114

B
background shading,
troubleshooting 91
bands and streaks,
troubleshooting 90
batteries included 124
bin, output
capacity 3
jams, clearing 87
locating 4
black and white scanning 65
blank copies, troubleshooting 99
blank pages
printing 43
troubleshooting 95
blank scans, troubleshooting 102
booklet settings
Windows 41
books
copying 58
scanning 67

C
cables

part numbers 110

USB, troubleshooting 96
Canadian DOC regulations 127

canceling
copy jobs 53
print job 40

scan jobs 63
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capacity
output bin 3
cartridge-door release, locating 4
cartridges
HP fraud hotline 72
part number 110
recycling 73, 123
replacing 73
reusing 73
status, checking 72
storing 72
warranty 113
cartridges, print
Macintosh status 24
characters, troubleshooting 92
cleaning
exterior 76
glass 65, 76
lid backing 75
paper path 75
scanner glass 55
color
scanning settings 65
color, scanning settings 64
comparison, product models 1
configuration page
printing 70
contacting HP 114
contrast settings
copy 55
control panel
cleaning page, printing 75
menus 11
messages, troubleshooting 80
scanning from (Macintosh) 25
settings 14, 20
control-panel
troubleshooting display
problems 83

copying
books 58
canceling 53
changing default number 52
contrast, adjusting 55
double-sided 59
edge-to-edge 56
enlarging 53
light/dark settings 55
media settings 56
media sizes 56
media types 56
media, troubleshooting 98
multiple copies 52
one-touch 52
photos 59
quality, adjusting 54
quality, troubleshooting 97
reducing 53
restore default settings 57
setup menu 11
size, troubleshooting 99
troubleshooting 99
cover pages 23, 43
creases, troubleshooting 93
crooked pages 92, 94
curled media 92
custom-size copies 53
custom-size paper settings
Macintosh 23
customer support
online 114
repacking device 116

D

dark copying 97

darkness, contrast settings
copy 55

demo page, printing 70
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density, print
changing settings 41
changing settings for copy
jobs 56
device status
Macintosh Services tab 24
dimensions
media 33
disposal, end-of-life 124
dots per inch (dpi)
specifications 3
dots, troubleshooting 90
dpi (dots per inch)
scanning 64
specifications 3
drivers
Macintosh settings 23
operating systems
supported 7
presets (Macintosh) 23
settings 14, 15, 20
supported 14

E
e-mail, scanning to

Macintosh 25

resolution settings 65
easy software installation 6
EconoMode setting 45
edge-to-edge printing 56
electrical specifications 118
embedded Web server 17, 22
embedded Web server (EWS)

features 71
end-of-life disposal 124
enlarging documents

copying 53
environmental specifications 119
environmental stewardship

program 122

EPS files, troubleshooting 107
error messages

control panel 80

critical 81
European Union, waste
disposal 124

extended warranty 116

F
faded print 90

134 Index

FastRes 3
FCC compliance 122
features

product 3
feeding problems,
troubleshooting 95
file, scanning to

Macintosh 25
Finnish laser safety
statement 128
firmware updates 76
first page

blank 43

use different paper
fraud hotline 72
fuser

media guidelines 42

23, 43

G

General Protection FaultException
OE 106

glass, cleaning 65, 76
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gray background,
troubleshooting 91

grayscale scanning 65

H

HP Customer Care 114

HP fraud hotline 72

HP Instant Support Professional
Edition (ISPE) 114

HP LaserJet Scan (Windows) 62

HP SupportPack 116

HP-Authorized Dealers 114

humidity specifications

environment 119

I
lllegal Operation errors 106
image quality
copy, troubleshooting 97
print, troubleshooting 90, 102
scans, troubleshooting 100,
102
installation, software
advanced 6
easy 6
types (Windows) 16

installing
Macintosh software for direct
connections 21
Macintosh software on
networks 21
Windows software 6, 16
Instant Support Professional
Edition (ISPE) 114
interface ports
cables, ordering 110
locating 5
types included 3
IP address
Macintosh,
troubleshooting 106

J

jams
causes of 83
locating 84
output-bin, clearing 87
preventing 89
print cartridge area,
clearing 88
trays, clearing 84

K
Korean EMI statement 127

L
landscape orientation, setting 45
laser safety statements 127, 128
LaserJet Scan (Windows) 62
lid, cleaning 75
light copying 97
light print, troubleshooting 90
lightness

copy contrast 55

faded print,

troubleshooting 90

lines, troubleshooting

copies 97

printed pages 90

scans 102
loading media

priority input tray 35

tray1 35
loose toner, troubleshooting 91
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M
Macintosh
driver settings 20, 23
drivers supported 7
installing printing system for
direct connections 21
installing printing system for
networks 21
Intel Core Processor 6
PPC 6
print settings 20
problems, solving 106
resize documents 23
scanning from control
panel 25
scanning from TWAIN-
compliant software 62
scanning page-by-page 25
scanning to e-mail 25
scanning to file 25
support 114
supported operating
systems 6, 20
USB card,
troubleshooting 107
Macintosh driver settings
custom-size paper 23
Services tab 24
maintenance agreements 116
material restrictions 124
Material Safety Data Sheet
(MSDS) 124
media
copy settings 56
curled, troubleshooting 92
custom-size, Macintosh
settings 23
default size for tray 36
document size, selecting 44
first page 23, 43
jams 83
orientation, setting 45
pages per sheet 24
pages per sheet, Windows 48
printing on special media 42
select size and type 38
size, changing 57
size, selecting 44
source, selecting 44
supported sizes 33
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troubleshooting 93
type, changing 57
type, selecting 44
wrinkled 93

memory
specifications 3

menu
control panel, access 11
Copy setup 11

Reports 12

Service 12

System setup 12
menu map

printing 70
mercury-free product 124
messages

control panel 80

critical 81
model

comparison 1
number, locating 5

multiple pages per sheet 24, 48
N
n-up printing
Windows 48
network

configuring 27
operating systems
supported 28
protocols supported 29
troubleshooting 104
network port
locating 5
settingup 29
networks
Macintosh installation 21
noise specifications 119
number of copies, changing 52

o

OCR software 63

on/off switch, locating 4

online support 114

operating environment,
specifications 119

operating systems supported 6,
7, 14, 20

operating systems, networks 28

optical character recognition
software 63

ordering supplies and
accessories 110

orientation, setting 45

output bin
capacity 3
locating 4

output quality
copy, troubleshooting 97
print, troubleshooting 90, 102
scans, troubleshooting 100,
102

P
packaging device 116
page-by-page scanning
(Macintosh) 25
pages
blank 95
excessive curl 94
misfeeding 94
not printing 96
skewed 92, 94
pages per minute 3
pages per sheet
Windows 48
paper
copy settings 56
curled, troubleshooting 92
custom-size, Macintosh
settings 23
document size, selecting 44
first page 23, 43
jams 83
pages per sheet 24
size, changing 57
size, selecting 44
source, selecting 44
supported sizes 33
supported types 38
troubleshooting 93
type, changing 57
type, selecting 44
wrinkled 93
paper input trays
feeding problems,
troubleshooting 95
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part numbers
cables 110
supplies 110
peer-to-peer printing
disclaimer 28
phone numbers
HP fraud hotline 72
photos
copying 59
scanning 68
scanning, troubleshooting 100
physical specifications 118
pixels per inch (ppi), scanning
resolution 64
portrait orientation, setting 45
ports
cables, ordering 110
locating 5
troubleshooting
Macintosh 107
types included 3
power
requirements 118
power consumption 118
power switch, locating 4
ppi (pixels per inch), scanning
resolution 64
presets (Macintosh) 23
print cartridge area jams,
clearing 88
print cartridges
door release, locating 4
HP fraud hotline 72
Macintosh status 24
part number 110
recycling 73, 123
replacing 73
reusing 73
status, checking 72
storing 72
warranty 113
print density
changing copy job settings 56
changing settings 41

print job
canceling 40
print media
supported 33
print quality

troubleshooting 90, 102
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printing
configuration page 70
connect to a network 29
demo page 70
direct connection to
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double-sided, Windows 46
edge-to-edge 56
Macintosh 23
menu map 70
on different media size 44
troubleshooting 96
USB connection 28
priority input tray
jams, clearing 84
loading 35
locating 4
priority, settings
problem solving
Macintosh problems 106
problem-solving
Windows issues 106
product
model comparison 1
serial number, locating 5
protocols, networks 29

14, 20

Q

quality
copy settings 54
copy, troubleshooting 97
print settings (Macintosh) 23
print, troubleshooting 90, 102
scans, troubleshooting 100,
102

R
Readiris OCR software 63
recycling

HP printing supplies returns and

environmental program 123

recycling supplies 73
redistribute toner 73
reducing documents

copying 53
regulatory information 122
removing software

Windows 16

repacking device 116
repetitive defects,
troubleshooting 93
replacing print cartridges 73
reports
configuration page
demo page 12, 70
menumap 12, 70
resize documents
Macintosh 23
resizing documents
copying 53
resolution
features 3
scanning 64
specifications 3

12, 70

S
safety statements
scale documents
Macintosh 23
scaling documents
copying 53
scanner
glass cleaning 55, 65
scanning
black and white 65
blank pages,
troubleshooting 102
books 67
canceling 63
color 64
file formats 64
from control panel
(Macintosh) 25
from HP LaserJet Scan
(Windows) 62
grayscale 65
methods 62
OCR software 63
page-by-page (Macintosh) 25
photos 68
quality, troubleshooting
102
resolution 64
speed, troubleshooting 101
to e-mail (Macintosh) 25
to file (Macintosh) 25
TWAIN-compliant software 62
WIA-compliant software 62

127, 128

100,
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scatter, troubleshooting 93
serial number, locating 5
service
critical error messages 81
HP-Authorized Dealers 114
part numbers 110
repacking device 116
service agreements 116
Service menu 12
Services tab
Macintosh 24
settings
driver presets (Macintosh) 23
drivers 15, 20
network printing 29
priority 14, 20
shipping device 116
size 118
size, copy
reducing or enlarging 53
troubleshooting 99
size, media
tray selection 38
skewed pages 92, 94
slow speed, troubleshooting
scanning 101
smeared toner,
troubleshooting 91
software
advanced installation 6
components 6
direct connection installation,
Macintosh 21
easy installation 6
embedded Web server 17,
22
network installation,
Macintosh 21
Readiris OCR 63
scanning from TWAIN or
WIA 62
settings 14, 20
supported operating
systems 6, 14, 20
Windows 17
Windows components 13
special media
guidelines 34
special paper
guidelines 34
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specifications

acoustic emissions 119

electrical 118

environmental 119

physical 118

product features 3
specks, troubleshooting 90
speed

print specifications 3

scanning, troubleshooting 101
Spool32 errors 106
spots, troubleshooting 90
status

Macintosh services tab 24

supplies, checking 72
storing

environmental

specifications 119

print cartridges 72
streaks, troubleshooting 90
supplies

HP fraud hotline 72

recycling 73, 123

replacing print cartridges 73

reusing 73

status, checking 72

storing 72
supply-status, Services tab

Macintosh 24
support

online 114

repacking device 116
supported media 33
SupportPack, HP 116
System setup menu 12

T
TCP/IP
operating systems
supported 28
protocols supported 29
technical support
online 114
repacking device 116
telephone numbers
HP fraud hotline 72
temperature specifications
environment 119
terminology 131
text, troubleshooting 92

toner
loose, troubleshooting 91
saving 45

scatter, troubleshooting 93

smeared, troubleshooting 91

specks, troubleshooting 90
toner cartridges. See print

cartridges

tray 1

jams, clearing 84
loading 35
locating 4

trays

capacities 3
capacity 38

default media size 36

feeding problems,

troubleshooting 95

jams, clearing 84
troubleshooting

blank pages 95

blank scans 102

checklist 78

control panel messages 80

control-panel display 83

copy quality 97

copy size 99

copying 99

critical error messages 81

curled media 92

EPS files 107

faded print 90

feeding problems 95

jams 83

lines, copies 97

lines, printed pages 90

lines, scans 102

loose toner 91

networks 104

pages not printing 96

pages too dark 97

pages too light 97

paper 93

print quality 90

repetitive defects 93

scan quality 100, 102
skewed pages 92, 94
text 92

toner scatter 93
toner smear 91
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toner specks 90 scanning from TWAIN or WIA

USB cables 96 software 62

wrinkles 93 software components 13, 17
TWAIN-compliant software, supported operating
scanning from 62 systems 6, 14
types, media Windows driver settings

tray selection 38 booklets 41

wrinkles, troubleshooting 93

u
uninstalling

Windows software 16
USB port

locating 5

Macintosh installation 21
troubleshooting 96
troubleshooting
Macintosh 107
type included 3

Use different paper/covers 43

Vv

vertical lines, troubleshooting 90
vertical white or faded stripes 97
voltage requirements 118

w
warning messages 80
warranty
Customer self repair 112
extended 116
print cartridges 113
product 111
watermarks 45
wavy paper, troubleshooting 92
Web sites
customer support 114
Macintosh customer
support 114
Material Safety Data Sheet
(MSDS) 124
weight 118
white or faded stripes,
troubleshooting 97
WIA-compliant software, scanning
from 62
Windows
driver settings 15
drivers supported 7
pages per sheet 48
problem-solving issues 106
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